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About This Document

This document is for system administrators and Data Center technicians. To read
this document, you must be familiar with your Data Centers and the Microsoft®
Windows® operating system.


Documentation Updates



Related Documentation



Conventions



Autonomy Product References



Autonomy Customer Support



Contact Autonomy

Documentation Updates
The information in this document is current as of Autonomy Connected® Backup
version 8.6.2. The content was last modified 30 May 2012.
You can retrieve the most current product documentation from Autonomy’s
Knowledge Base on the Customer Support Site.
A document in the Knowledge Base displays a version number in its name, such
as IDOL Server 7.5 Administration Guide. The version number applies to the
product that the document describes. The document may also have a revision
number in its name, such as IDOL Server 7.5 Administration Guide Revision 6.
The revision number applies to the document and indicates that there were
revisions to the document since its original release.
It is recommended that you periodically check the Knowledge Base for revisions
to documents for the products your enterprise is using.
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To access Autonomy documentation
1. Go to the Autonomy Customer Support site at
https://customers.autonomy.com
2. Click Login.
3. Enter the login credentials that were given to you, and then click Submit.
The Knowledge Base Search page opens.
4. In the Search box, type a search term or phrase. To browse the Knowledge
Base using a navigation tree only, leave the Search box empty.
5. Ensure the Documentation check box is selected.
6. Click Search.
Documents that match the query display in a results list.
7. To refine the results list, select one or more of the categories in the Filter By
pane. You can restrict results by
 Product Group. Filters the list by product suite or division. For example,

you could retrieve documents related to the iManage, IDOL, Virage or
KeyView product suites.
 Product. Filters the list by product. For example, you could retrieve

documents related to IDOL Server, Virage Videologger, or KeyView Filter.
 Component. Filters the list by a product’s components. For example, you

could retrieve documents related to the Content or Category component in
IDOL.
 Version. Filters the list by product or component version number.
 Type. Filters the list by document format. For example, you could retrieve

documents in PDF or HTML format. Guides are typically provided in both
PDF and HTML format.
8. To open a document, click its title in the results list.
To download a PDF version of a guide, open the PDF version, click the Save
icon
in the PDF reader, and save the PDF to another location.
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Related Documentation

Related Documentation
The following documents provide more details on Connected Backup:


Product Overview



Installing PC Agents



Installing Mac Agents



Administering Mac Agents



Installing the Data Center



Administering the Data Center



Upgrading the Data Center



Data Center Disaster Recovery



Account Management Web Services Development



DataTransfer API Administration Guide



Connected Backup for PC Agent Quick Start



Connected Backup for Mac Agent Quick Start



Web Services Programming Reference



Connected Backup Release Notes



Connected Backup Agent Version Matrix



Connected Backup Interoperability Matrix



Connected Backup Requirements Matrix



Connected Backup Application Localization Matrix



Connected Backup Documentation Localization Matrix

In addition, all Connected Backup applications include online help.
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Conventions
The following conventions are used in this document.

Notational Conventions
This document uses the following conventions.
Convention

Usage

Bold

User-interface elements such as a menu item or button.
For example:
Click Cancel to halt the operation.

Italics

Document titles and new terms. For example:
 For more information, see the IDOL Server
Administration Guide.
 An action command is a request, such as a query or
indexing instruction, sent to IDOL Server.

monospace font

File names, paths, and code. For example:
The FileSystemConnector.cfg file is installed in
C:\Program Files\FileSystemConnector\.

monospace bold

monospace italics

Data typed by the user. For example:


Type run at the command prompt.



In the User Name field, type Admin.

Replaceable strings in file paths and code. For
example:
user UserName
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Conventions

Command-line Syntax Conventions
This document uses the following command-line syntax conventions.
Convention

Usage

[ optional ]

Brackets describe optional syntax. For example:
[ -create ]

|

Bars indicate “either | or” choices. For example:
[ option1 ] | [ option2 ]
In this example, you must choose between option1
and option2.

{ required }

Braces describe required syntax in which you have a
choice and that at least one choice is required. For
example:
{ [ option1 ] [ option2 ] }
In this example, you must choose option1, option2,
or both options.

required

Absence of braces or brackets indicates required
syntax in which there is no choice; you must type the
required syntax element.

variable

Italics specify items to be replaced by actual values. For
example:

<variable>

-merge filename1
(In some documents, angle brackets are used to denote
these items.)
...

Ellipses indicate repetition of the same pattern. For
example:
-merge filename1, filename2 [, filename3
... ]
where the ellipses specify, filename4, and so on.

The use of punctuation—such as single and double quotes, commas,
periods—indicates actual syntax; it is not part of the syntax definition.
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Notices
This document uses the following notices:

CAUTION A caution indicates an action can result in the loss
of data.

IMPORTANT An important note provides information that is
essential to completing a task.

NOTE A note provides information that emphasizes or
supplements important points of the main text. A note supplies
information that may apply only in special cases—for example,
memory limitations, equipment configurations, or details that
apply to specific versions of the software.

TIP A tip provides additional information that makes a task
easier or more productive.

Autonomy Product References
This document references the following Autonomy products:
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Autonomy Customer Support

Autonomy Customer Support
Autonomy Customer Support provides prompt and accurate support to help you
quickly and effectively resolve any issue you may encounter while using
Autonomy products. Support services include access to the Customer Support
Site (CSS) for online answers, expertise-based service by Autonomy support
engineers, and software maintenance to ensure you have the most up-to-date
technology.
To access the Customer Support Site, go to
https://customers.autonomy.com
The Customer Support Site includes:


Knowledge Base: The CSS contains an extensive library of end user
documentation, FAQs, and technical articles that is easy to navigate and
search.



Case Center: The Case Center is a central location to create, monitor, and
manage all your cases that are open with technical support.



Download Center: Products and product updates can be downloaded and
requested from the Download Center.



Resource Center: Other helpful resources appropriate for your product.

To contact Autonomy Customer Support by e-mail or phone, go to
http://www.autonomy.com/content/Services/Support/index.en.html

Contact Autonomy
For general information about Autonomy, contact one of the following locations:

®

Europe and Worldwide

North and South America

E-mail: autonomy@autonomy.com

E-mail: autonomy@autonomy.com

Telephone: +44 (0) 1223 448 000
Fax: +44 (0) 1223 448 001

Telephone: 1 415 243 9955
Fax: 1 415 243 9984

Autonomy Corporation plc
Cambridge Business Park 
Cowley Rd
Cambridge CB4 0WZ
United Kingdom

Autonomy, Inc.
One Market Plaza
Spear Tower, Suite 1900
San Francisco CA 94105
USA
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Agent Overview

CHAPTER 1

This chapter explains the role of the Agent, the components that comprise the
Agent, and how to deploy the Agent.


The Role of the Agent



Support Center



Agent Accounts



Agent Connections to Data Centers



Agent Deployment Tasks

The Role of the Agent
The Agent is software that you install and configure on client computers. You use
the Agent to back up files on the client computers and to retrieve files that you
previously backed up.
Every Agent has an account in the Data Center. The account contains information
about the Agent configuration.
The Agent sends files to the Data Center for backup. To perform a backup, the
Agent scans the hard drives of the computer on which it resides for files that
require backup. Next, the Agent contacts the Data Center to initiate a backup
session. The Agent prepares the files for backup and notifies the Data Center if
users have deleted previously backed-up files since the last backup session.
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To retrieve or restore files, the Agent requests the files from the Data Center, then
downloads or restores the files to the client computer.
The Agent initiates communication with the Data Center. The Data Center cannot
contact an Agent independently.
IMPORTANT The Agent does not support multi-user environments.
Although you can install the Agent on a computer that hosts more than
one user account, you can only associate one user account with the
Agent. Additionally, more than one user account on a computer that hosts
the Agent can cause problems during file retrieval and backups.

Support Center
Support Center is a Web-based management application that technicians use to
manage Agent configurations and accounts. You can use Support Center from
any computer with Internet Explorer 6.0 or later and a network or Internet
connection.
Use Support Center to manage the following information:


Technician accounts



Communities and Agent accounts



Agent settings



Agent profile and Web site settings



Agent versions



Agent rules



Reports

Support Center Interface
The Support Center interface consists of two panes.
The left pane displays a hierarchical tree that represents the organization of Agent
accounts on your Data Center (if you host your Data Center) and your
communities.
The right pane displays information relevant to the node that you select in the left
pane.
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Support Center

The following figure shows the Support Center interface.

Nodes
The following table describes the major nodes and subnodes in the Support
Center interface:

®

Item

Description

Top-level node

Expand the top-level node to view the nodes and subnodes in the
tree. The top-level node uses the Data Center server name and is
the top-level community.

Accounts

Find and display information about the user accounts in your Data
Center.

Technicians

Create and modify logon accounts for technicians who use Support
Center.

Report
Templates

Create templates to generate reports that track account use and
other statistics.
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Item

Description

Reports

Display report results after you use the Report Templates node to
generate a report.

Legacy PC
Configurations

Use the Configuration Summary page to create, edit, and view
version 7.x or earlier PC Agent configurations.

Configurations

Create, edit, and view Profile and Website settings, Mac Agent
configurations and version 8.0 or later PC Agent configurations.

Communities and Subcommunities
You can create communities and subcommunities to organize accounts. A
community appears as a node below the top-level node. A subcommunity appears
as a subnode below a community node.
The following figure shows Subcommunity 1 under Community 1.

Each community and subcommunity has its own Accounts, Technicians,
Configurations, Report Templates, and Reports nodes.

Technicians
Technicians include Data Center administrators, Information Technology
individuals, Technical Support individuals, and others who support your user
community. To use Support Center to perform administrative tasks, a technician
must create a technician account. A technician can give the account as many
permissions as necessary, and can delegate different tasks to supporting
personnel.
For more information, see “Set Up Communities and Accounts” on page 33.

Communities
A community is a group of accounts with a common element. You can create
communities based on department, office location, Agent configuration, or any
category that helps you manage your accounts efficiently.
For more information, see “Set Up Communities and Accounts” on page 33.
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Support Center

Agent Configurations
An Agent configuration is a set of settings and features that you want to apply to
one or more Agents. You can create configurations to meet enterprise needs such
as a backup schedule, security, and features. After you create an Agent
configuration, users can go to the Account Management Website to download an
Agent Setup file that uses the configuration. The Agent Setup applies the
configuration settings when users employ it to install an Agent, recover an Agent
account, or upgrade and Agent. Alternatively, you can install the Agent Setup file
on client computers.
For more information, see “Create Agent Configurations” on page 57.

Rules
The Agent uses rules to determine which files to back up. When you build an
Agent configuration, you must assign a rule set.
For more information, see “Create Agent Rule Sets” on page 65.

Reports
You can use Support Center to create and run reports about the use and status of
accounts. You can run reports once or regularly. You can configure reports to
include charts. You can save reports in XML format.
For more information, see “Agent History and Reports” on page 169.

Inheritance of Support Center Objects
A Support Center object can be an Agent configuration, a report template, or a
technician account. The inheritance feature lets you use top-level objects in all
subcommunities. In other words, when you create objects in a community, the
objects apply to the community and its subcommunities.
Support Center displays inherited objects in the left pane in regular text. It displays
objects that you create in the community in bold text. You cannot edit the inherited
objects. However, you can edit the objects you create.

Duplicate Object Names
Because communities contain inherited objects and objects that you create, a
community can contain multiple objects that have the same name.
For example, if a parent community has a configuration named Finance, its
subcommunity inherits that configuration. You also can create a new configuration
in the subcommunity named Finance. Support Center displays the inherited
community in regular text and the configuration you create in bold text.

®
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For best practice, use unique names or unique descriptions for all objects you
create.

Open Support Center
You can open Support Center from any computer with Internet Explorer 6.0 or
later and a network or Internet connection.
Open Support Center in the following ways:


Subscription users. Open a Web browser, and then enter the URL that the
enterprise that hosts the Data Center provides.



Licensed users. Open a Web browser, and then enter a URL in one of the
formats described in the following table:

SSL Status
SSL is enabled

SSL is not
enabled

Using DNS or WINS to store
server names

Not using DNS or WINS to
store server names

https://server_name/
supportcenter/

https://ip_address/
supportcenter/

where server_name is the name
of the server that hosts Support
Center

where ip_address is the IP
address of the Support Center
server

http://server_name/
supportcenter/

http://ip_address/
supportcenter/

where server_name is the name
of the server that hosts Support
Center

where ip_address is the IP
address of the Support Center
server

Internet Explorer Preparation for FDCC Environments
You must install the following applications in a Federal Desktop Core
Configuration (FDCC) environment to allow Internet Explorer access to Support
Center in order to manage your Connected Backup accounts:


SCBrowserUtils.dll signed ActiveX® control



Adobe SVG viewer NPSVG3.dll ActiveX control



Java runtime environment version 1.5/1.6

These applications require administrative rights to install.
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SCBrowserUtils.dll Signed ActiveX Control
Support Center uses the SCBrowserUtils.dll ActiveX control for the following
functions:


Downloading Agent Setup files



Uploading Agent File Sets



Uploading Branding-related files



Uploading MSI certificates



Downloading report XML file results



Running the ACE utility to update Legacy Agent configurations

To install the application
1. Use Internet Explorer to log in to the Support Center as a technician.
2. Navigate to an Agent configuration page to download an Agent Setup file.
3. During the page display, Internet Explorer prompts the user to install the
SCBrowserUtils.dll ActiveX control.
4. Click Install.
Internet Explorer installs the control. Once the Download button is selectable,
the control is installed.
NOTE In Internet Explorer 8, to enable the ActiveX control
1. In Internet Explorer, select Tools > Manage Add-ons.
2. In the Manage Add-ons window, right-click BrowserUtility Class, and
then click More Information.
3. In the More Information window, click Allow on all sites, and then
click Close.
4. Close the Manage Add-ons window and return to Internet Explorer.

®
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Adobe SVG Viewer NPSVG3.dll ActiveX Control
Support Center uses the Adobe SVG viewer ActiveX control to display graphical
report results.
To install the application
1. Download the installation file for the control from http://www.adobe.com/svg/
viewer/install.
2. Install the control by running the setup file and following the on-screen
instructions.

Java Runtime Environment (JRE 1.5/1.6)
Support Center uses the Java runtime environment to launch and use the
navigation tree (ScTreeApplet.jar) and Agent (SignedAgent.jar) applets.
To install the application
1. Download the installation file for the runtime environment from http://
www.java.com/en/download/manual.jsp.
2. Install the runtime environment by running the setup file and following the
on-screen instructions.
NOTE Support Center does not support Internet Explorer with JRE 1.7
installed. If you use Internet Explorer with JRE 1.7 installed to access the
Support Center, Internet Explorer might experience an error and stop
unexpectedly.

Agent Accounts
Each deployed Agent has an account in the Data Center. Each account has a
unique 10-digit number that identifies it. The Data Center uses this account
number to label and organize all data that it backs up from the client. To view the
account number, search for an account in Support Center. Record this number in
case you need to reinstall the account.
As a technician, you can use Support Center to complete the following tasks:
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Change the account status.



Manage account features.



Manage security settings.

Autonomy Connected® Backup Administering PC Agents

Agent Connections to Data Centers



Create and change Agent configurations.

As a user, you can use the Account Management Website to complete the
following tasks:


Change your password.



Update your profile (e-mail address, address, and telephone number).

For information about how to manage accounts, see “Manage Accounts” on
page 37.

Agent Connections to Data Centers
To connect to the Data Center, the Agent can use any Transmission Control
Protocol/Internet Protocol (TCP/IP) connection, including local area networks
(LANs) and wide area networks (WANs). The Agent supports Windows Sockets
1.1 and Windows Sockets 2.0 and uses whichever version available.
The amount of network traffic that Agents generate depends on the following
conditions:


Number of Agents that you deploy



File backup rules



Agent backup schedules relative to your network peak and off-peak hours of
use for your network

Agent Connection Properties
To connect to the Data Center, the Agent uses the DNS name or IP address of the
Data Center server. In a mirrored configuration, you can designate which of two
Data Center servers the Agent contacts as the primary server.
The Data Center replicates data from one server to the other. If the primary server
is busy, the Agent connects to the secondary server to back up files and retrieve
files.
When you run the Data Center setup, you can configure which Data Center server
acts as the primary server. You can designate different servers as the primary
server for different communities. For example, if you manage a mirrored
configuration and have six distinct communities, you can designate Server 1 as
the primary server for Communities A, B, and C. You then can designate Server 2
as the primary server for communities D, E, and F. When you designate different
servers for different communities, each server shares the volume of Agent
transactions.

®
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Proxy Servers
If the client computer and the Data Center reside on different sides of a proxy
server, configure the Agent to connect to the Data Center through the proxy
server.
The Agent can connect through the following proxy servers:


SOCKS proxy server



Non-SOCKS proxy server



Software firewall

You configure the proxy server settings in Support Center. For more information,
refer to Support Center Help.

Connect Through a SOCKS Proxy Server
When you use a SOCKS proxy server, all connections to the Data Center first
require a connection to the SOCKS server. The server then uses the IP/Port
information in the Agent configuration to connect to the Data Center.
To configure an Agent to connect to the Data Center through a SOCKS proxy
server, use Support Center to edit the proxy server settings. Specify the IP
address and port number for the proxy server. The Agent uses the SOCKS
protocol to tell the proxy server the IP address and port number (16384) of the
Data Center.
If you use SOCKS, do not reconfigure your proxy server. For more information
about how to configure Agent proxy server settings, refer to Support Center Help.

Connect Through a Non-SOCKS Proxy Server
If your enterprise uses a non-SOCKS-compliant proxy server, configure the Agent
and your proxy server to communicate with the Data Center. You configure the
Agent proxy server information to map the Data Center IP address to the IP
address of the proxy server, and you specify the port on which to connect to the
proxy server. You can use domain names instead of IP addresses when you
specify the Data Center and proxy server mapping. If you use a mirrored pair,
designate this mapping for both the primary and secondary servers.
The Agent uses the mapping to connect to the IP address of the appropriate proxy
server (using the appropriate port) instead of connecting directly to the Data
Center server. The firewall then routes the connection to the Data Center that
resides behind the proxy server.
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Connect Through Firewalls
If the client computer uses a third-party firewall, such as Zone Labs ZoneAlarm®
or Symantec Norton Internet Security™, configure the Agent as though the
computer does not use a proxy server. The firewall software might prompt the
user to allow the Agent to connect before it can back up or retrieve files.

Network Interruptions
If the initial attempt to connect to a stand-alone Data Center server fails, the Agent
records the failure in the Agent History. In a mirrored environment, if an Agent
cannot establish a network connection to its primary server, the Agent attempts to
connect to the secondary server. If the Agent connects to its secondary server, it
proceeds as normal and completes its task. If the Agent cannot connect to its
secondary server, it records the failed attempt in the Agent History.
If an interruption in the network connection occurs or the connection fails during a
backup or retrieval, the Agent attempts to reconnect and finish the operation after
it waits for a predefined period of time. After the wait period, the Agent attempts to
reconnect to the Data Center server. The Agent does not attempt to connect to a
different Data Center server to continue an aborted backup or retrieval. When the
Agent reconnects, it starts at the beginning of the last file it worked on before the
connection failed.

Agent Deployment Tasks
You begin a first-time Agent deployment by logically grouping your user accounts
into communities. You then define Agent configurations that have appropriate
permissions and features for each community. You can have several different
Agent configurations that you can assign to accounts and communities
individually.
After you create or modify an Agent, you can download the Agent Setup program
to users’ computers for registration and installation.

Create Communities and Subcommunities
You can configure multiple Agent configurations, each with different properties, to
suit the needs of different groups in your enterprise. Before you create new Agent
configurations, consider the different groups in your enterprise and determine
which Agent features benefit each group.

®
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Use Support Center to create subcommunities based on factors such as
department, geographical location, or job function. After you create a
subcommunity, you can move an Agent configuration to that subcommunity, or
create a new Agent configuration with properties that meet the requirements of
the subcommunity.
For more information, see “Set Up Communities and Accounts” on page 33.

Specify Properties and Settings
The Configurations node in Support Center contains the following types of Agent
configurations:


PC Configurations. PC Agent configurations.



Mac Configurations. Mac Agent configurations.

Support Center can contain the following Legacy Agent configuration:


Legacy PC Configurations. Version 7.x PC Agent configurations

To define an Agent configuration, you must define the following components:


Agent Versions. Determines the software version (7.x or 8.x) of the Agent and the
language.



Agent Settings. Determines the settings and features available to users (7.x or 8.x).



Agent Rule Sets. Determines the files included and excluded for backup (7.x or 8.x).



Profile and Website Settings. Determines the features that users can gain access to
through the Account Management Website. The Account Management Website lets
users register accounts, download Agent software, and manage their accounts.

For more information about Agent settings, versions, and rules, see “Create Agent
Configurations” on page 57.

Distribute the Agent Software
After you define the Agent features during configuration, Support Center creates
an Agent Setup program that installs the Agent software on a client computer. The
Agent Setup program is a Windows Installer .msi file.
To distribute the file, use the following methods:
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Account Management Website. Users log on to this Web site to register
accounts and download the Agent Setup program. You can use the Account
Management Website to distribute only files customized for one user. If you
use this method to distribute the files to other users, the backup process does
not work correctly. All users must download their own file from the Account
Management Website. For more information, refer to Installing PC Agents.
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Support Center download. You can download the Agent Setup program from
Support Center and distribute a generic Agent Setup file to users so that they
can install the Agent themselves. For more information, refer to Installing PC
Agents.



Disk image distribution. You can install an Agent on a computer and then
create a disk image to clone to other computers. For more information, refer to
Installing PC Agents.



Hands-free installation. You can download the Agent Setup file from Support
Center and use the installation command-line interface to install the Agent on
multiple computers simultaneously without user participation. For more
information, refer to Installing PC Agents.

Register and Install the Agent
When you register an Agent, the Data Center establishes an account for the
Agent. The account identifies the Agent client computer to the Data Center server.
An account number in the Data Center represents the client computer and the
files on that computer.
Installation and registration occur in one of the following ways:


After a user logs on to the Account Management Website and enters profile
information, the Website communicates with the Data Center to register a new
account. Each user must register on the Account Management Website
individually to get an Agent Setup program file that is particular to the user’s
account. After the user registers the Agent, the user downloads the Agent
Setup program and installs the Agent. Each user downloads an .msi file for
their own use. The .msi file allows access only to that user’s account.



After you download the Agent Setup program from Support Center, you install
and register the Agent in one of the following ways:
 Use the Agent Startup Wizard. To use the Wizard, a technician must use

Support Center to enable it for the Agent configuration. For more
information, refer to Installing PC Agents.
 Use the Agent installation command-line interface. You can use an XML

file to specify registration information. For more information, refer to
Installing PC Agents.
If you do not provide registration information, the Agent registers anonymously.
That means that the Data Center identifies the Agent by only a computer name,
and not by a user name.

®
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During registration, the Data Center assigns a 10-digit account number to the
Agent. The Data Center uses the account number to label and organize the data it
receives in a backup. The Agent account is unique to the computer. You cannot
use the same account number to install more than one Agent. Also, you cannot
have multiple Agents or accounts on the same computer.
The Data Center tracks each Agent that you register and the total number of
registrations against the total number of users permitted by your organization’s
license agreement, and the number of licenses allocated to a community where
the Agent registers. When you use up the licenses, the Data Center does not
accept new registrations from Agents until you buy more licenses, allocate
additional licenses to the community, or cancel unused accounts.
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Set Up Communities and
Accounts

CHAPTER 2

This chapter explains how to set up communities and subcommunities, manage
accounts, work with technician accounts, allocate and manage licenses, and
apply bandwidth throttling to Agent backups.


Communities



Subcommunities



Manage Accounts



Managing General Account Functions



Agent Security



Technician Accounts



Licenses for Agent Accounts



Manage Licenses and Licensed Features



Apply Bandwidth Throttling During Agent Backups

®
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Communities
A community is a group of Agent accounts that share common characteristics,
such as configuration settings, the geographical location of the clients, or similar
bandwidth throttling requirements. You can use communities to run reports, edit
settings, upgrade Agent configurations, and manage accounts.

Communities in Support Center
Each community that you create in Support Center appears as a node in the left
pane of the Support Center interface. The node contains subnodes that represent
the accounts, technicians, reports, configurations, and subcommunities in the
community.
Each community or subcommunity inherits objects from the top-level community
Data Center (root level) node. For example, technicians whose permissions you
define in the root level of your community can gain access to all subcommunities.
You can use the Agent configurations, reports, and other objects that are defined
at the root level of your community in any subcommunity.

The Default Community
If you host your Data Center, depending on the permissions that are assigned to
your technician account, you might have access to a community labeled Default.
When you install a self-hosted Support Center, the installation procedure creates
this default community.
The Default community includes the Default Agent configuration, which contains
default settings and rules. You can use this community to organize your Agents, or
as a model to construct your communities. You must set the correct permissions
for the technician account that you use to log on to Support Center so that the
account allows you access to the Default community.
If you do not host your own Data Center, you have access to specific
subcommunities in the Default community. However, you might not have
permissions to gain access to the top-level Default community.

New Communities
You can create as many communities and subcommunities as necessary to
organize your accounts. All subcommunities that you create inherit the default
Agent configuration in the root community. However, any new Agent
configurations that you create in a new subcommunity are available only to that
subcommunity and any of its subcommunities.
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For more information, refer to Support Center Help.
To create a new community
1. Log on to Support Center.
2. Click Tools > Add Community.
The Add Community page opens.
3. In the Community Name field, enter a community name.
4. Click Save.
The name of the community appears in the left pane of the Support Center.
The community node contains subnodes representing the accounts,
technicians, reports, and configurations for the community.

IMPORTANT You can rename and move communities. However, you
cannot delete communities.

Subcommunities
You can create subcommunities in any community that you can access. You can
use subcommunities to divide your Agent accounts into smaller categories, based
on geographic location, departments, bandwidth throttling, or other criteria. You
can reassociate a subcommunity with a different parent community, which is
useful if you want your communities to reflect the changes in your organization.
For more information, refer to Support Center Help.
NOTE To manage Agents more easily, create separate subcommunities
for each type of Agent that you plan to deploy. Also keep Agent
configurations for different operating systems in separate
subcommunities.
For more information about Agent configurations, see “Create Agent
Configurations” on page 57.

®
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Create Subcommunities
To create a subcommunity
1. Log on to Support Center.
2. Click the community for which you want to create the subcommunity.
3. From the Tools menu, select Add Subcommunity.
The Create Subcommunity page opens.
4. In the Community Name field, enter a name for the subcommunity.
5. Click Save.
The name of the subcommunity appears in the left pane of the Support
Center. The subcommunity node contains subnodes representing the
accounts, technicians, reports, and configurations for the community.
For more information, refer to Support Center Help.

Agent Accounts in Subcommunities
Agent accounts in a subcommunity share characteristics with the parent
community, but they have distinct characteristics that set them apart from the
parent community. For example, you might create one community to represent the
Agents in your branch office. In this parent community, you can create
subcommunities to represent the departments in the branch office, such as
Finance, Accounting, and Marketing.
The Agents in each subcommunity inherit versions, settings, and rule sets from
the parent community. They also can contain configurations unique to each
subcommunity. For example, you define common rules at the community level for
your entire organization. Then, for each group in your organization, you have
subcommunities for which you can define unique settings. You then use the
common rules and the Agent settings that you define for each group to create
Agent configurations for each subcommunity.

Disable Registration in Communities
After you deploy Agents throughout your enterprise, you can use Support Center
to disable registration for communities and subcommunities. When you disable
registration, no one can use a copy of Agent Setup to register an account that you
did not intend to create. If you must add new accounts to the community or
recover an account, you can enable registration.
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Manage Accounts
Use Support Center to perform the following account management tasks:


View an account number.



View account information.



Change account status.



Manage general functions.



Manage Agent security.



Gain access to the Account Management Website to manage an account.

View an Account Number
Each deployed Agent has an account in the Data Center. Each account has a
10-digit number that uniquely identifies it. The following is an example of an
account number:
10203-61718
The sixth digit in the account number (the digit following the dash) is a check digit.
Some of the Data Center database tables drop the check digit and use a nine-digit
format instead (for example, 102031718.)
The Data Center uses this account number to label and organize all data backed
up from the client.
You can view an account number in the following ways:


From the Agent interface



From Support Center

To view your account number from the Agent interface
1. Open the Agent interface.
2. Click Help > About Connected® Backup/PC Agent.
The About Connected Backup window opens. Your account number is at the
bottom of the window.
You can use the Agent interface to view the number of only your own account.

®
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To view an account number from the Support Center
1. Use your technician ID and password to log on to Support Center.
The organization that hosts your Data Center provides the URL you need to
log on.
2. In the left pane of Support Center, click Accounts.
The Account Search page opens in the right pane.
3. On the Account Search page, enter one of the following kinds of information:
 Account name
 Organization name
 Department

4. Click Search.
The Accounts page lists the account number for every account that matches
the search criteria.

View Account Information
To view information about an account
1. Log on to Support Center.
2. In the left pane of Support Center, click Accounts.
The Account Search page opens in the right pane.
3. On the Account Search page, enter one of the following kinds of information:
 Account name
 Organization name
 Department
 Account number
TIP The fastest way to find an account in Support Center is to search for
the account number. If you do not know the account number, you can use
the account name, organization name, department, or other identifying
criteria to search for the account. For more information, refer to Support
Center Help.

4. Click Search.
The Accounts page opens and lists the account number for every account that
matches the search criteria.
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5. Click the number of the account.
The Account Summary page opens and lists information about the account.

Change Account Status
The status of an account determines whether the account can connect to the Data
Center. If you change the account status, you can temporarily or permanently
disable backup and retrieval for an Agent.
If you change the account status, you can block access to the Data Center from
client computers that were stolen or are no longer used. For example, when an
employee leaves your organization, you can cancel the account for that employee
so that unauthorized users cannot gain access to the files that the former
employee previously backed up.
The account status includes the following options:
Status option

Description

Active

An account can connect to the Data Center and perform backup
and retrieve operations.

On Hold

An account temporarily cannot connect to the Data Center and
perform backup and retrieve operations.
For example, you can place an account on hold if a employee
associated with the account takes a long-term leave from your
organization. When the user returns, you can change the status
of the account back to Active.

Canceled

An account cannot connect to the Data Center and perform
backup and retrieve operations. The Compactor labels the
information that the Agent backed up as expired and, after a
defined expiration period, removes the information from the Data
Center server.
For example, you can cancel a user account if the employee
associated with the account permanently leaves your
organization.

Canceled and Data
Deleted

®

The compaction process ran on a canceled account, and the files,
archives and encryption key associated with the account no
longer exist on the Data Center.
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To change the status of an account
1. Open Support Center and search for the Agent account.
2. When Support Center displays the search results, click the Agent account
number.
The Account Summary page opens.
3. On the Account Summary page, click Account Status.
The Change Account Status page opens.
4. Select a status option.
For more information, refer to Support Center Help.
5. To save your changes, click Change Status Now.
For more information, refer to Support Center Help.

Managing General Account Functions
Use Support Center to manage the following general account functions:


Reserve accounts.



Change the primary server for an account.



Order images on media for accounts.



Change an Agent configuration.



Send messages to Agents.



Display backup messages.



Display the Agent Status icon.

Reserve Accounts
As an alternative to the standard account registration, you can reserve accounts
in specific communities. To reserve accounts, you can use Support Center to
generate account codes. Users can enter the code or ticket to register under the
Agent community.
When users register new accounts, the Data Center verifies the code or ticket that
they specify. If the code or ticket is valid, the Data Center registers the account in
the community where the technician created the reservation.
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NOTE Reserved accounts use client licenses on the Data Center in the
same way as Active accounts.

For more information about how to reserve accounts, refer to Support Center
Help.

Change the Primary Server for an Account
In mirrored or clustered environments, Agents use one Data Center server as their
primary server during backup or retrieval. The Agent always attempts to contact
its designated primary first. If the primary is offline, the Agent connects to the
mirror of the primary server to complete the operation.
You can use Support Center to change the primary server to the secondary
server.
To designate a primary server for an Agent
1. Open Support Center and search for the Agent account.
2. When Support Center displays the search results, click the Agent account
number.
The Account Summary page opens in the right pane.
3. On the Account Summary page, click Primary Server.
If the Agent does not belong to a clustered or mirrored environment, Primary
Server is not a link.
The Change Primary Server page opens.
4. Select a primary server.
5. To change the primary server to the one that you selected, click Save.
For more information, refer to Support Center Help.

Ordering Account Images on Media
If an account loses its data and it is inconvenient to use a network connection to
restore the data, you can order an image of the account data on different types of
media. For more information, see “Order Media” on page 166.

®

Autonomy Connected Backup Administering PC Agents

•
•
• 41
•
•
•

Chapter 2 Set Up Communities and Accounts

Change an Agent Configuration
The Agent configuration determines the following:


Agent rules



Security settings



Interface controls



Profile and Website settings

If you use multiple configurations within one community, you can change the
configuration of an Agent in that community. The next time that the Agent
connects to the Data Center, the Agent downloads the new configuration.
To change an Agent configuration
1. Open Support Center and search for the Agent account.
2. When Support Center displays the search results, click the Agent account
number.
The Account Summary page opens.
3. Click the Assigned Configuration link.
The Change Agent Configuration page opens.
4. Select the appropriate configuration from the displayed list.
5. To change the configuration to the one that you selected, click Save and
Deploy.
For more information, see “Create Agent Configurations” on page 57 and refer to
Support Center Help.

Send Informational Messages to Agents
You can send informational messages to Agents. For example, you want to
provide instructions to users for an upcoming Agent configuration upgrade. This
feature is different from the message notification that you can enable when you
change the status of an account. For more information about how to change the
status of an account, see “Change Account Status” on page 39 and refer to
Support Center Help.
When you create informational messages, the Agent receives the messages the
next time it connects to the Data Center. If configured to do so, the Agent displays
a message notification window that it received one or more messages from the
Data Center. Users must open the Agent User interface to view the messages in
the Message panel of the Summary tab.
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To send a message to one or more Agents
1. Log on to Support Center.
2. Search for an account or create an account group.
3. Perform one of the following actions:
 To send a message to a single account, from the Account Summary page,

select Tools > Send Message to Agent.
 To send a message to a group of accounts, from the Group Accounts

page, select Group > Send Message to Agents.
4. In the Send Message to Agent page, enter the message that you want to
send.
5. Click Send Message.
For more information, refer to Support Center Help.

Display Backup Messages
Depending on your Agent configuration, the Agent can display a message
notification window in the following situations:


When a backup completes and the Agent User interface is closed



When a backup does not successfully complete after four days.

To enable backup messages
1. Log on to Support Center.
2. Select a community and expand the Configurations node, then expand the
PC subnode.
The PC Agent Configuration summary page opens.
3. Expand the Agent Settings node, and select a setting configuration.
The Edit Agent Settings - General page opens.
4. On the Edit Agent Settings - General page, click Display.
The Edit Agent Settings - Display page opens.
5. In the Messages section of the Edit Agent Settings - Display page, select the
message setting that you want to enable.
6. Click Finish.
For more information, refer to Support Center Help.
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Enabling the Display of the Agent Status Icon
You can configure the Agent to display a status icon in the notification area of the
Windows taskbar. The icon indicates whether a backup or retrieve is in progress.
The icon also includes a shortcut menu that lets users do the following tasks:


Open the Agent User interface.



Use the Account Management Website (if enabled) to manage an account.



Start a backup.



Start a backup, and then shut down or log off the computer.



Cancel a backup.



View Agent version information.

To display of the Agent Status icon, complete the following steps:
1. Log on to Support Center.
2. Select a community and expand the Configurations node, and then the PC
subnode.
3. Expand the Agent Settings node and select a setting configuration.
4. On the View Agent Settings page, click Display.
5. In the Agent Visibility section, select Show the Agent icon in the taskbar
notification area.
6. Click Finish.
For more information, refer to Support Center Help.

Agent Security
Every account has an encryption key that the Agent creates during installation
and registration. The Agent and Data Center uses the encryption key to encrypt
and decrypt each file that the Agent backs up.
For additional security, you can configure the Data Center to notify users by e-mail
when anyone retrieves a file from an account. Technicians can take appropriate
action if an unauthorized person retrieves files from a specific account.
You can enable e-mail notification at the community or subcommunity level. You
cannot configure e-mail notification for specific Agent configurations.
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NOTE Ensure that the DCAlerter service is running and configured with
a valid e-mail server. For more information about how to configure the
DCAlerter service, refer to Data Center Management Console Help.

To enable e-mail notification
1. Log on to Support Center.
2. Select a community or subcommunity.
3. Click Tools > Email Notification.
The Change Email Notification Status page opens.
4. Select the appropriate option and click Save.
For more information, refer to Support Center Help.

Technician Accounts
Technician accounts let you control who has access to Support Center, and who
has access to the Agent retrieve feature.
An administrator assigns the Support Center Administrator technician ID during
the Data Center installation. The technician ID provides access to Support Center
controls. Use this technician ID to create your subcommunities and other
technician accounts.
If you want multiple staff members to use Support Center, create a technician
account for each staff member. You can set permissions to control the level of
access a technician has to Support Center features. For example, you might limit
a technicians’ access to specific communities.
To create a technician account
1. Log on to Support Center.
2. Select a community.
3. Select the Technicians node.
4. In the Add Technician page, enter the required information and select the
permissions you want to assign to the account.
5. Click Add Technician.
For more information, refer to Support Center Help.
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Licenses for Agent Accounts
The Data Center licenses control the number of accounts that you can connect to
a Data Center. They also enable licensed features such as MyRoam® or
Connected EmailOptimizer®.
If you host your Data Center, you receive a license file to use when you install the
Data Center. For more information, refer to Installing the Data Center.
If you back up your files to a Data Center that another company manages, one of
the following can occur:


Your top-level community inherits unused licenses from a parent community.



The technician that manages the parent community allocates a specific
number of licenses for your top-level community.

How Licenses Affect the Support Center Display
Based on the types of licenses that you buy, Support Center displays the following
configuration nodes in the left pane of the user interface:
Software Licenses

Version

Support Center display

PC and Mac Agents

8.3 and later

Configurations node, PC subnode, and
Mac subnode

PC Agents

8.0 through 8.2.2

Configurations node, PC subnode

Legacy PC Agents

7.x and earlier

Legacy PC Configurations node

If you log on to Support Center and you or another technician changes the
licenses, Support Center does not display the change in the left pane until you
refresh the view or log into a new session.
For example, if you log on to Support Center and another technician removes
licenses for PC and Mac Agents, you continue to see the PC and Mac subnodes
under the Configurations node until you start a new session.

License Inheritance and Allocation
When you register an Agent in a community or subcommunity on the Data Center,
the registration completes only if a license is available. Additionally, without an
available license, the Agent cannot connect to the Data Center.
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A technician can allocate licenses to subcommunities, or subcommunities can
inherit licenses from a parent community. By default, lower-level communities
inherit licenses from parent communities. For example, if your top-level node in
Support Center has access to 1,000 licenses and you create two communities
below the top-level node, each subcommunity has access to the 1,000 unused
licenses in the parent community.
You can use license allocation to control the number of licenses to each
community or subcommunity can access. For example, you have a total of 1,000
licenses available, and you have two communities: Operations and Engineering. If
you expect the Engineering community to require more registered accounts than
the Operations community, you can allocate 700 licenses to the Engineering
community and 300 licenses to the Operations community. You can adjust the
allocation of licenses at any time.
PC Agents and Mac Agents share the same license pool. For more information
about license inheritance and allocation, see “License Allocation Examples” on
page 50.

Used and Unused Licenses
The Data Center considers a license in use when any of the following conditions
exist:


Accounts register in a community.
For example, a community has access to 500 licenses and 100 accounts
register in the community. The number of licenses in use for the community is
100 and the number of unused licenses is 400.



You allocate a specific number of licenses to a subcommunity.
For example, your top-level community has 1,000 licenses available for use,
and you allocate 600 of the licenses to a subcommunity. The number of
licenses in use in the top-level community is 600 and the number of unused
licenses is 400.



Accounts register in a community and you allocate some of the licenses to a
subcommunity.
For example, your top level-community has 1,000 licenses. A hundred
accounts register in the top-level community, and you allocate 600 licenses to
a subcommunity. The number of in use licenses is 700 and the number of
unused licenses is 300.
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Licensed Features for Communities
You can enable or disable the MyRoam and EmailOptimizer features for a
selected community.

Feature State Inheritance
Each feature in a community inherits its default state from the parent community.
However, you can enable a feature in a parent community and disable the feature
in its subcommunities. You also can disable MyRoam at the configuration level.
For more information, refer to Support Center Help.
If you change the state of licensed features in a parent community, you affect its
subcommunities in the following ways:


If you disable licensed features in a parent community, you disable the
features in its subcommunities. For example, you enable MyRoam in a
subcommunity and disable MyRoam in the parent community. As a result, you
also disable MyRoam in the subcommunity.



Licensed features in subcommunities return to their previously set states if you
re-enable licensed features in the parent community. For example, you disable
a licensed feature in a subcommunity and in the parent community. You then
re-enable the licensed feature in the parent community. As a result, you also
re-enable the feature in the subcommunity.

For more information, refer to Support Center Help.

Expired Licenses
When licenses expire, the following behavior occurs:


If licenses in the Data Center License File expire, the Data Center server no
longer accepts connections from Agents.



If the licenses for a product type (PC or Mac) expire, the Data Center no
longer accepts connections from those Agents.



If licenses expire, new Agents cannot register in the Data Center.



If a registered PC Agent attempts to back up files or retrieve files, and the
licenses expire, the process fails. The History tab in the Agent User interface
displays a failed event.



If a user attempts to register an account with an expired license, the Account
Management Website informs the user that the license is not valid.

To get more licenses, contact your Sales Representative.
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Effect of Licenses on Accounts and Communities
The availability of unused and unexpired licenses affect the following tasks:


Agent registration
If no licenses are available in a community, or if the licenses expire, new
Agents cannot register in the Data Center and the Account Management
Website displays an error message. If the Agent cannot register an account, it
cannot back up or retrieve files. To let new Agents register, buy or allocate
additional licenses to the affected community.



Changing account status
 If no unused licenses exist for the community in which an account is

registered, you cannot change its status to Active or On Hold.
 If you change the status of an account to Canceled, the license that the

account used becomes available. A new account can register and use this
license.
 If you change the status for multiple accounts simultaneously, and you do

not have an available license for every accounts in the group, the Data
Center changes the status for only a subset of the selected accounts.
 The Data Center does not change the status for all accounts. The Results

page in Support Center lists the changes that did not occur. For example,
a community had five available licenses, and you tried to change the
status of seven accounts. The status of two of the accounts remains the
same.


Moving communities
When you move communities from one location to another, the destination
community must have a sufficient number of unused licenses for the
communities that you move.
For example, you have a community named Accounting that has 500 licenses
allocated for its use, and you want to move it to a new parent community
named GlobalOperations. The GlobalOperations community must have at
least 500 or more unused licenses to accommodate the Accounting
community.
After you move a community, the licenses that it used become available to the
original parent community and the moved community uses licenses that it
obtains from its new parent community.
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Moving accounts
If you move an account from one community to a different community, the new
community must have an unused license of the appropriate product type that
the account can use. After you move the account, the license it used in the
original community becomes available. The moved account uses a license
from its new community.
If you move a group of accounts from one community to a different community,
and the new community does not have enough licenses of the appropriate
product type for all of the accounts, Support Center moves some accounts
and displays a message that indicates that some accounts did not move. To
move the remaining accounts, buy or allocate additional licenses to the
community.

Manage Licenses and Licensed Features
This section contains an example of license allocation. It also describes how to
perform the following tasks:


Allocate licenses.



Enable or disable licensed features.

License Allocation Examples
Assume that you host your Data Center. Your Data Center License File provides
you with 5,000 account licenses.
After you install your Data Center, you create the following communities:
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Engineering



Accounting



Marketing
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Inherited Licences
Initially, all communities inherit the licenses. Because you have not yet explicitly
allocated the licenses, each community has access to the 5,000 licenses. The
following figure shows the initial license allocation.

As users register accounts in the individual communities or as you allocate
licenses to other communities, the number of licenses in use increases and each
community that inherits its licenses has access to fewer licenses.
For example, 100 accounts register in the Engineering community, and you do not
explicitly allocate any licenses to other communities. You have 4,900 unused
licenses to which all communities have access.

Allocated Licenses
To control the use of licenses, and to avoid a situation where one community runs
out of needed licenses, you allocate some of the licenses. In addition, your
enterprise charges other enterprises for backup services, so you must control the
number of licenses to which other enterprises have access.
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You know the following information:


The Engineering division has 500 client systems that must back up their data.



The Accounting division has 300 client systems that must back up their data.



The Marketing division has 50 client systems that must back up their data.

After you allocate required licenses to each division, you have 4,150 unused
licenses and 850 licenses in use. In this example, a license is in use after you
allocate it to another community. If you create another community and let it inherit
licenses, it would have access to the 4,150 unused licenses.
The following figure shows the license allocation for this example.

Licenses Allocated to Subcommunities
The Engineering division can create subcommunities and allocate licenses to
these subcommunities. After you inform the Engineering division that their
community is available, the administrator in the Engineering division divides the
community into the following subcommunities:
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Product A



Product B
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Initially, the Engineering community and each subcommunity has access to the
500 allocated licenses, with the following use of licenses:


Fifty accounts register in the top-level community. Each subcommunity now
has access to 450.



You allocate the remaining unused licenses as follows:
 Product A receives 100 licenses.
 Product B receives 200 licenses.

You have 150 remaining licenses. Up to 150 new accounts can register in the
top-level community, or you can allocate any of these licenses to existing
subcommunities or to a new subcommunity, or both, as shown in the following
figure:

Allocate Licenses
To make it easier to manage licenses, create different communities for different
types of licenses. For example, create a community for Mac licenses, and a
different community for PC licenses.
To allocate licenses
1. Log on to Support Center. Use a technician ID that has permissions to allocate
licenses in sub-communities.
2. In the left pane of the Support Center interface, select a community or
subcommunity.
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3. On the Community Status page, click Allocate Licenses.
The Allocate License page opens.
4. Select the appropriate allocation options.
For more information, refer to Support Center Help.
5. To save your selections, click Save.
Support Center displays the following message:
The license allocation changes have been saved.
If you do not have permission to allocate licenses for a selected community,
Support Center displays the View License Summary page instead of the Allocate
Licenses page. You can use this page to view the current license allocation.
For more information, refer to Support Center Help.

Enable or Disable Licensed Features
To manage licensed features
1. Log on to Support Center. Use a technician ID that has permissions to allocate
licenses in sub-communities.
2. In the left pane of the Support Center interface, select a community or
subcommunity.
3. On the Community Status page, click Manage Features.
The Manage Features page opens.
4. In the Manage Features dialog box, select the feature that you want to enable
or disable, and then click Save.
Support Center displays the following message:
The Manage Feature changes have been saved.
For more information, see “Licensed Features for Communities” on page 48.

Apply Bandwidth Throttling During Agent Backups
You can use the bandwidth throttling feature to limit the amount of network
bandwidth that Agents use during backups. If you throttle bandwidth during Agent
backups, you can allocate more bandwidth to other network activities and to
user’s Internet applications. When you use bandwidth throttling for Agent
backups, backups are less intrusive, but take longer to complete.
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NOTE
 Bandwidth throttling applies only to Agents version 8.2 and later.
 Bandwidth throttling applies to only Agent backups. It does not apply
to Retrieve operations.
 Set bandwidth throttling limits that are appropriate for your network.
The Data Center does not check the available bandwidth of your
network against the bandwidth throttling limits that you set in Support
Center. If you set maximum bandwidth limits that exceed actual data
transfer speed of your network, the bandwidth throttling does not
reduce Agent intrusiveness during backups.

You can set the following bandwidth limits:


Minimum bandwidth required for an Agent to perform a backup



Maximum bandwidth to allocate to an Agent performing a backup



Maximum bandwidth to allocate to all Agents performing backups

You also can establish a schedule to identify the peak, medium peak, and off peak
network traffic times, and vary the bandwidth allocations accordingly.
You can configure bandwidth throttling at the Data Center level and the
community level. At the Data Center level, you can choose whether to throttle
bandwidth for all accounts that the Data Center manages. At the community level,
you can choose whether to throttle bandwidth for the accounts in the community,
or you can choose to inherit the bandwidth throttling configuration (throttled or not
throttled) from the parent community. When a subcommunity inherits bandwidth
throttling from its parent community, and you specify a maximum shared
bandwidth, the maximum shared bandwidth is shared among all Agents in the
parent communities and any subcommunities that inherit bandwidth throttling.
To configure bandwidth throttling
1. Log on to Support Center.
2. In the left pane of the Support Center interface, select a community or
subcommunity.
3. On the Community Status page, click Bandwidth Throttling.
The Bandwidth Throttling - Options page opens.
4. Select a bandwidth throttling option.
For more information, click Help.
5. Click Save.
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Support Center displays the following message:
Your bandwidth throttling options have been saved.
For more information, refer to Support Center Help.
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CHAPTER 3

This chapter explains the components that make up an Agent configuration. It
also explains how to create Agent configurations.


About Agent Configurations



Configuration Components



Create an Agent Configuration

About Agent Configurations
You create Agent configurations in Support Center to specify the features that are
in the Agents that you deploy. Agent configurations also contain the settings and
rules that control the behavior of an Agent after you install it on a client computer.
Support Center supports the following types of Agents:


7.x Legacy PC Agents



8.x or later PC Agents



8.3 or later Mac Agents
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Configuration Components
An Agent configuration contains the following components:


Profile and Website settings



Agent versions



Agent settings



Agent rule sets

Support Center compiles Agent configurations from a set of components that each
specify some of the Agent features. You can gain access to the configuration
information for each community.
To gain access to the configuration information for a community
1. Open Support Center.
2. In the left pane of the Support Center interface, under the name of the
community in which the Agent resides, expand Configurations, and then
expand PC.
The following sections describe the configuration components in detail.

Profile and Website Settings
The Profile and Website settings determine the information and features that are
available to users in the Account Management Website. They also determine the
information that is in users’ profiles, and the fields that are in the Agent Startup
Wizard. In Support Center, the Profile and Website settings for each community
appear in the Configurations node.
For more information about the Account Management Website, see “Deploy the
Account Management Website” on page 99.
For more information about Profile and Website settings, refer to Support Center
Help.

Agent Versions
Agent versions point to an Agent file set of a specific version and language. For
example, you have an Agent version named Marketing PC. When a new version
of the Agent software becomes available, you can download the new version and
apply it to your deployed Agents.
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For best practice, consider the following recommendations:


When you create new Agent version in Support Center, do not include the
version number in the name. For example, do not use Marketing versionX.
Instead, use Marketing. If you include the version number in the name, the
name becomes obsolete when you update the Agent version.



Based on the needs of your organization, you might need to create one or
more Agent versions. For example, you have computers in different
departments with different backup requirements. You can create an Agent
version for each department.



You can use the same Agent version with several or all Agent configurations.
When a new version of the Agent software is available, update only the Agent
version and not every Agent configuration.

Agent Settings
The Agent has optional features specific to your license agreement that you can
enable or disable. Agent settings determine which features are accessible to the
Agent user. The settings contain parameters that govern the Agent backup and
retrieve features, such as the backup schedule and backup type. You also can
enable security features such as proxy server settings and password protection of
retrievals.

Agent Rule Sets
The Agent uses rule sets to determine which files to select during a backup. You
can specify Agent rules in Support Center when you create or modify an Agent
configuration.
Support Center includes a default rule set that you can associate with one or more
Mac Agent configurations. You also can create your own rule sets. If you let users
modify their backup sets, they also can create rules that determine which files the
Agent selects for backup. For more information, see “Create Agent Rule Sets” on
page 65.

Default Agent Configuration
The Support Center installation creates a default Agent configuration. The default
configuration has a name similar to Default PC version Configuration, where
version is the Agent version number. The default configuration resides at the root
level of the tree in Support Center and is available to all of your communities. You
might want to create your own configuration with a unique version, settings, and
rules. However, you can use the default configuration as a reference when you
create your own configurations.
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For more information, refer to Support Center Help.
The default configurations contain the following components:


Default Agent Version



Default Agent Settings



Default Agent Rule Sets



Default Profile and Website Settings

Create an Agent Configuration
Use Support Center to create the Agent configuration and its components. The
technician ID that you use to log on to Support Center must include the Modify
Agent Configurations permission.
To create an Agent configuration
1. Allocate licenses.
2. Create an Agent version.
3. Create Agent settings.
4. Create Profile and Website Settings.
5. Create an Agent rule set.
6. Create the Agent configuration.
The following sections describe these steps in greater detail.

NOTE Perform the steps to create an Agent configuration in the order in
which the steps appear in the guide.

Allocate Licenses
To create a new Agent configuration for a community, the community must have at
least one available license.
To verify that a community has at least one available license
1. In the left pane of the Support Center interface, click the community node.
The Community Status page opens.
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2. In the Account Summary section, look at the value in the Unused column for
the PC and Mac license type and verify that at least one unused license is
available.
If no licenses are available, you can change your license allocations.
3. To change your license allocations, click Allocate Licenses.
The Allocate Licenses page opens.
4. Select the appropriate allocation options.
For more information, click Help.
5. To save your selections, click Save.
Support Center displays the following message:
The license allocation changes have been saved.

Create an Agent Version
To create an Agent version
1. Expand the Configurations node in the community where you want to create
the configuration.
2. Expand the PC node.
3. Click Agent Versions.
The Create Agent Version page opens.
4. Enter the Agent version information.
Only PC Agent versions are available in the Agent drop-down list.
5. Click Create.
The Edit Agent Version - Description page opens.
6. Enter a description for the version, then click Save and Deploy.
The name of the Agent version appears in the left pane under the Agent
Versions node.

Create Agent Settings
To create Agent settings
1. Expand the Configurations node in the community where you want to create
the configuration.
2. Expand the PC node.
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3. Click Agent Settings.
The Create Agent Settings - General page opens.
4. Configure the Agent Settings.
For more information, click Help.
5. When you complete the Agent Settings, click Finish.
The name that you assigned to the setting appears in the left pane under the
Agent Settings node.

Create Profile and Website Settings
To create Website settings
1. Expand the Configurations node in the community where you want to create
the configuration.
2. Click Profile and Website Settings.
The Create Profile and Website Settings - General page opens.
3. When you complete the Website settings, click Finish.
The name that you assigned to the setting appears in the left pane under the
Profile and Website Settings node.
For more information, click Help.

Create an Agent Rule Set
To create an Agent rule set
1. Expand the Configurations node in the community where you want to create
the configuration.
2. Expand the PC node.
3. Click Agent Rule Sets.
The Create Rule Set page opens.
4. Configure the rule set.
For more information, click Help on each page of the Rules wizard.
5. When you complete the rule set, click Finish Rule Set.
The name that you assigned to the rule set appears in the left pane under the
Agent Rule Sets node.
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Create the Agent Configuration
To create a new Agent configuration
1. In Support Center, expand a community node, and then expand the
Configurations node.
2. In the right pane, clear Use inherited configuration settings.
If you do not clear this setting, the configurations that you create for the
community are inactive. That means that you cannot download an Agent
Setup file from the community.
3. Click the PC subnode.
4. In the right pane, on the Configurations menu, click Create.
5. Enter a meaningful community name, such as “Finance Department.”
6. From the drop-down lists, select the following:
 An Agent version
 Agent settings
 Profile and Website settings
 Agent rule set

Each list contains the components you previously created and the default
components.
7. To create the configuration, click Save and Deploy.
After you create the Agent configuration, two things happen:
 The Download menu becomes available. If you want to distribute the

Agent Setup file, use this menu to download it to your computer.
 If the Account Management Website is installed for your Data Center, a

URL for Account Management Registration appears. Copy and send this
case-sensitive URL to users whom you want to register and install an
Agent account.
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CHAPTER 4

This chapter explains the types of rules that the Agent uses to determine which
files to include and exclude in backup. It also explains how to use Support Center
to create rules.


Rule Types



The Rule Matching Process



Rule Categories



Create Rules
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Rule Types
The Agent uses rules to determine which files to include or exclude from backups
and recoveries.
Rule types determine the order in which the Agent processes rules. The following
table describes the rules types that the Agent uses and how they determine
processing order:
Rule Types

Description

Locked

Rules that technicians define through the Support Center.
Other types of rules cannot override locked rules.
The Agent tries to match files with locked rules before it
examines any other type of rule.

User-created

Rules that users define on their local Agent and associate with
files on their local system.
To define user-created rules, users must have permission to
modify their backup sets.
User-created rules do not override locked rules, but they
override unlocked rules.
The Agent tries to match files with user-created rules after it
examines locked rules.

Unlocked

Rules that technicians define from the Support Center.
Locked rules and user-created rules override unlocked rules.
The Agent tries to match files with unlocked rules after it
examines locked rules and user-created rules.

The Rule Matching Process
The Agent processes rules according to the following factors:


Rule logic. The way the Agent processes each type of rule (locked, user-created, or
unlocked). For more information about rule types, see “Rule Types” on page 66.



Rule precedence. The position of rules in the rule list.

When the Agent scans a drive, it examines locked rules first. The Agent moves
through the list of locked rules in top-down order until it finds a rule that applies to
one or more files. You determine the precedence of rules in a list when you use
the Support Center Rules wizard to create the rule set.
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Rule Logic
If the Agent matches a locked rule to a file or group of files, the Agent stops
comparing the matched file or files to other rules. However, if the Agent cannot
match a file to a locked rule, the Agent compares the file to user-created rules. If
the file matches a user-created rule, the Agent stops comparing that file with
additional rules. If the file does not match a user-created rule, the Agent continues
to compare the file to unlocked rules. If the files does not match an unlocked rule,
the Agent does not include the file in the back up.
The following figure shows the logic that the Agent follows to process rules:

File

Locked Rules?

No

User-created rules?

No

Unlocked rules?

Yes

Yes

Yes

Apply locked rules.

Apply user-created
rules.

Apply unlocked
rules.

No

Do not consider
the file for backup.

For example, a user creates a rule that excludes all .mp3 files from backup.
During a scan, the Agent compares the user’s files against all of the locked rules
in the rules set and finds no rule that pertains to .mp3 files.
The Agent then compares the user’s files to the user-created rules. The Agent
finds a rule that excludes all .mp3 files from backup. The Agent drops all .mp3
files from the backup list. The Agent then finds an unlocked rule that includes all
.mp3 files in the backup. Because user-created rules take precedence over
unlocked rules, the backup excludes .mp3 files.
The Agent uses the following process to determine which files to select for
backups:
1. The Agent determines which drives to exclude from the backup set.
Users can use the Agent interface to exclude drives from backup. The Agent
does not scan these excluded drives. Excluded drives do not show up on the
Backup Set tab in the Agent User interface.
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2. The Agent tries to match files to rules based on rule type.
The Agent examines rule types in the following order:
a. Locked rules
b. User-created rules
c. Unlocked rules
3. When the Agent scans the hard drive, the Agent tries to match files to the list
of rules under each rule type.
The Agent examines the first rule in the list of files for each rule type. It
compares the rule definition to the file location, name, and type.
If the file does not match this rule, the Agent examines the next rule in the list.
The Agent continues this process until it finds a rule that matches the file. After
the Agent finds a matching rule, it uses the rule category type to classify the
file as user-created files, application or system files, or an excluded file. Based
on the rule type and how you configure the Agent, the Agent selects or does
not select a file for backup.
If a file does not match any rules, the Agent does not consider the file for
backup.
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Rule Precedence
Assume that you want to create a set of locked rules that cause the Agent to
select most files with a .doc extension for backup and not select files that start with
the letter x. The following figure illustrates how the order of rules results in
different behaviors:

LOCKED RULES FOR RULE SET 1

LOCKED RULES FOR RULE SET 2

First Rule:

First Rule:
Category

User-Created Files

Category

Exclusions

Rule Name

Include x*.doc files

Rule Name

Exclude x*.doc files

Folder

*

Look in Folder

*

Scope

All folders and
subfolders

Scope

All folders and
subfolders

File name

*

File name

x*

File types

doc

File types

doc

Second Rule:

Second Rule:
Category

Exclusions

Category

User-Created Files

Rule Name

Exclude x*.doc files

Rule Name

Include x*.doc files

Folder

*

Folder

*

Scope

All folders and
subfolders

Scope

All folders and
subfolders

File name

x*

File name

*

File types

doc

File types

doc

In this example, all files with the .doc
extension match the first rule in the list of
locked rules. The Agent does not compare
any of the files with the .doc extension to the
second rule.
Using these rules, the Agent selects all files
with a .doc extension. Because all of these
files match the first rule, the Agent does not
apply the second rule to files with a .doc
extension.
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In this example, all files that start with x and
have a .doc extension match the first rule in
the list of locked rules. The Agent does not
select any of these files for backup.
Using these rules the Agent selects only the
files that do not start with x and have a .doc
extension.
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Rule Categories
Rule categories determine whether the Agent considers files for backup. For more
information, see Support Center Help. The following table describes each rule
category:
Rule Category

Description

User-Created Files rules

Include user-created files, such as spreadsheets and
documents, in backups.

System or Application
Files rules

Rules that pertain to system and application files.

Exclusion rules

Exclude files from backups.
NOTE If you exclude a file from a backup, you cannot
retrieve it.

Create Rules
You can create rules in the following ways:


Use the Agent Rules Wizard in the Support Center to modify a default rule set
and save it under a new name.



Use the Agent Rules Wizard in the Support Center to create a new rule set
without using a default set as a template.



Use the Agent User interface.

Best Practices for Creating Rules
When you create rules, consider the following best practices:
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Consider the types of files that you want to select for backup, and determine
which rule category applies to the files. For example, you want the Agent to
back up all .mp3 files. Because .mp3 files are files that users create, you must
create User-Created Files rule to include .mp3 files in backups.



Do not rely on the absence of a rule to exclude a file from backup. To exclude
files from backup, create an exclusions rule to specify the exclusion. For
example, assume you are a technician who wants to exclude all .mp3 files
from backups. Because the Agent does not consider files for backup unless

Autonomy Connected® Backup Administering PC Agents

Create Rules

the file matches a rule, you decide that you can exclude .mp3 files from
backup if you do not create a rule for them. However, a user creates a rule that
specifies .mp3 files for backup. As a result, the Agent backs up the user’s
.mp3 files. To ensure that the Agent does not back up .mp3 files, create a
locked exclusions rule.

Use Rule Sets
Rule sets are collections of rules. You can create rule sets for different
organizations, locations, or types of computer users. For example, you create a
rule set for Corporate Engineering that specifies which files you want the Agent to
back up and which files you want the Agent to exclude. Every Agent contains
default rule sets. You can use the default rule sets as they are or as a starting
point to create custom rule sets.

Rules Page
After you open the Agent Rules Wizard in Support Center and enter general
properties for a rule set, you can enter rule definitions in the Rules page. The
following figure is an example of the Rules page:
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The following table lists the elements in the Rules page:
Element

Description



Locked Rules tab. Lists rules that the Agent evaluates before all other
types of rules. Users cannot use the Agent interface to modify locked rules.



Unlocked Rules tab. Lists rules that the Agent evaluates after it evaluates
locked rules and user-created rules. Users cannot use the Agent User
interface to modify unlocked rules, but they can create user-created rules
that override unlocked rules.




Rules list. Lists the rules for the selected rule type.
Rule editing buttons
 New. Opens the New Rule window. Use this window to specify the
details for the new rule. When you save the rule, the Rules wizard
places the new rule at the end of the list.
 Edit.Opens the Edit Rule window. Use this window to change the
details of an existing rule.
 Convert to Custom. Lets you create a copy of a built-in rule that you
can modify.
 Cut. Lets you remove rules from the current rule set and put them in the
Support Center clipboard. You can paste these rules into another rule
set.
 Copy. Makes a copy of the selected rules and puts them in the Support
Center clipboard. You can paste these rules into another rule set or
move a group of rules to a different location in the current rule set.
 Paste. Puts the rules in the Support Center clipboard into the current
rule set.
 Remove. Permanently deletes a rule from the current rule set. Support
Center does not put the rule in its clipboard.



Details of selected rule. The rule definitions that the Agent uses to match
rules with files. The Agent uses the Category detail to determine which files
to select based on the backup type.



Rule set buttons
 Back. Opens the Rule Set - General page.
 Next. Not used on this page.
 Finish Rule Set. Saves the current rule set. The Rules wizard displays
this button if you have permission to modify the rule set.
 Close. Closes the window.
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Use the Agent Rules Wizard
To create, edit, or remove rule sets and rules, use the Agent Rules wizard. For
more information, refer to Support Center Help.
To use the Rules wizard
1. Log on to Support Center.
2. Select a community where you want to create or edit a rule set.
3. Expand the Configurations node and expand the PC subnode.
4. Complete one of the following tasks:
 To create a new rule set

i.

In the left pane, select Agent Rule Sets.
The Create Rule Set page of the Rules wizard opens.

ii. Use the Rule Set - General page to specify a name for the rule set and
the drives that you want the Agent to exclude.
 To modify a rule set

i.

Expand the Agent Rule Sets node and select the rule set that you
want to modify.
The View Rule Set page of the Rules wizard opens.

ii. Save the rule set under a different name, and then follow the Rules
wizard to edit or remove rules in the rules list.
5. To save all of the new or modified rules in the rule set, click Finish Rule Set.
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Agent Security Features

CHAPTER 5

This chapter explains how the Agent security features ensure that unauthorized
users do not intercept and decode files while they travel between the Agent and
the Data Center.


Encryption



Access Control List Management



Unauthorized Access Prevention

Encryption
When you register an Agent, the Agent generates an encryption key (a random
alphanumeric string) and stores it locally on the Agent host computer. The Agent
does not store the encryption key in clear text. Instead, the Agent applies 128-bit
Advanced Encryption Standard (AES) encryption to the key. You cannot change
the level of encryption that the Agent uses to encrypt the key.
During Agent registration, the Agent uses Secure Sockets Layer protocol (SSL) to
securely transmit the encrypted key to the Data Center. The Data Center escrows
the key, in encrypted format, on its Data Center server so that you can recover the
key if you need to fully recover the Agent account.
Before the Agent performs a system backup, it uses the encryption key to encrypt
the files in the backup set. This ensures that hackers cannot intercept and decode
the files while they travel between the Agent and the Data Center during the
backup. The files remain encrypted on the Data Center. When the Agent initiates
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a retrieval, the Data Center sends the encrypted files to the Agent. When the
Agent receives the files, it decrypts them and then downloads them to the client
computer. Because the Agent stores the encryption key locally, only the Agent
that encrypted the files can decrypt them.

Access Control List Management
Administrators can apply different file permissions and extended attributes to
accounts to limit the access that non-administrative users have to files, folders,
and drives. If configured to do so, the Agent backs up file permissions and
extended attributes that are on the client computer and retrieves them along with
the files the user requests.
When Agents retrieve files for computers, they reapply the file permissions and
extended attributes so that only authorized users can view the files. If you have
computers in your organization that multiple users share, the Agent installed on a
computer can back up and retrieve files for all of the users. However, it does not
let users retrieve files for which they do not have file permissions. The Agent also
backs up the Encrypting File System (EFS) attributes of files on servers.

Unauthorized Access Prevention
This section describes Agent features that prevent unauthorized access to files.

Security Certificates
To prevent unauthorized access to files during transmission from the Agent to the
Data Center, Data Center Setup embeds a security certificate in the Agent. The
Agent uses the security certificate to authenticate the Data Center server to
perform the following tasks:
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Registration



Upgrade



Backup



Retrieve



Edit Profile
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Password Protection for Retrieval
To prevent unauthorized access, you can require users to supply a technician ID
and password to retrieve a file.
When you create Agent configurations, enable password protection for the
retrieve feature. If you enable this feature, users must enter their account
password to retrieve files.
For more information, refer to Support Center Help.

Prevent Access to Files on a Lost or Stolen Computer
To prevent access to files on a lost or stolen computer
1. Recover the Agent account to a computer that has a name that is different
from the lost or stolen computer.
The Data Center prevents access to accounts from more than one computer
name. Restoring the account to a replacement computer with a name that is
different from the lost or stolen computer ensures that the account is
protected.
2. To allow a computer name change
a. Open Support Center.
b. Search for the Agent account.
c. When Support Center displays the search results, click the account
number in the Account column.
d. Select Tools > Allow Computer Name Change.
The Allow Computer Name Change page opens.
e. Click Allow Change.
This procedure deletes the computer name that is associated with the
account. The next time the Agent runs a backup, the Data Center recognizes
that the account moved to a new computer.
3. Restore the account data.
4. Use Support Center to cancel the account from the lost or stolen computer,
and remove the old account data from the Data Center server.
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Brand Product Components

CHAPTER 6

This chapter explains how to use Support Center to brand the Agent software,
Support Center, and the Account Management Website.


Overview of Branding Feature



Branding Options for Agents



Branding Options for Support Center



Branding Options for the Account Management Website



Brand Product Components

Overview of Branding Feature
You can brand the product in the following ways:


Replace the default product branding with your company branding.



Display the “Powered by” logo with your company branding.



Remove the “Powered by” logo so that it is not displayed with your company
branding.

®
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You can brand the following product components:


Agent



Support Center



Account Management Website

If you host your Data Center and have access to the top-level community, you can
brand the entire Data Center. If you do not host your Data Center, you can use a
technician ID to brand any community or subcommunity that to which you can
gain access.
If you host your Account Management Website, you can brand the entire Website.

Agent Branding Options
You can brand the following components in the following ways:
Component

Description

Branding options

Agent installation
program

The program that installs the Agent.

 Product name
 Default installation folder
where the Agent Setup
executable installs the
Agent software
 Product group location
 “Powered by” logo

Agent splash
screen
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The window that opens when you
start your computer.

Product logo
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Overview of Branding Feature

Component

Description

Branding options

Agent User
interface

The application that let you perform
backups, retrievals, and otherwise
manage your Agent account. The
Agent User interface includes the
following components:

 Product name

 Agent Startup Wizard
 Welcome to the Agent window

 Product logo for the
following components:
 Agent console
 Agent About window
 “Powered by” logo

 Enter Password dialog box
 Synchronizing screen
 Agent console
 Agent About window
 Shortcut menu for the Agent
Status icon in the system tray
Desktop elements

The following elements on the
Windows desktop:

 Product name
 “Powered by” logo

 Agent Desktop shortcut icon
 Agent Add/Remove programs
entry
 Windows Start menu executable
Windows registry

Branding appears in the Windows
registry under ...\Connected\
custom_name for the following
registry keys:

 Product name
 “Powered by” logo

 TargetDir
 AppSetupMSIName

NOTE The branding-related keys are in the following registry location,
based on the Agent operating system:
32-bit: HKEY_LOCAL_MACHINE\SOFTWARE\Connected
64-bit: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\
Connected
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Support Center Branding Options
You can brand Support Center in the following ways:
Component

Description

Branding options

Logon dialog box

The dialog box that lets you enter
credentials to log on to Support Center

 Product image

Change Password
dialog box

The dialog box that lets you change the
password that you use to log on to
Support Center

 Product image

Application header

The header that displays at the top of
all application pages

 Product image

 “Powered by” logo

 “Powered by” logo

 “Powered by” logo

Account Management Website Branding Options
You can brand the Account Management Website in the following ways:
Component

Description

Branding options

Account Management
Website

The web-based application that lets
users perform the following tasks:

 Web site name

 Register a new account and
download the Agent software

 Product logo on
the Web site
 “Powered by” logo

 View account information
 Modify profile information
 Recover accounts
 Use MyRoam® to retrieve files
 Order backed-up files on media

Branding Options for Agents
You can brand the following elements in the Agent User interface:
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Splash screen



Agent installer windows



Agent user interface
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Brand the Agent Splash Screen
The following figure shows the elements that you can brand the Agent splash
screen:

Replace the default
product image
with your product image.

Add the
“Powered by”
logo.
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Branding in the Agent Installation Wizard
The Installation Wizard guides you through the installation of the Agent. The
following figure shows the elements that you can brand in the Installation Wizard:
Replace
the default product name
with your product name.

Replace the default logo with
your logo.

Add the “Powered by”
logo.

NOTE Your logo must be the same size as the logo in the previous
figure. The logo image file is a composite of the logo over a white
background.
If your logo image file is too large, the title text (in this example, the word
“Welcome”) might appear on top of the logo image.
For more information, see “Requirements for Agent Graphics” on
page 94.
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Branding Options in the Agent User Interface Window
The following sections describe the elements that you can brand in the Agent user
interface. The Agent user interface includes the following components:


Welcome to the Agent window



Enter Password dialog box



Synchronization window



Agent console

Brand the Welcome to the Agent Window
The following figure shows the elements that you can brand in the Welcome to the
Agent window:
Replace the default product name
with your product name.
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Brand the Enter Password Dialog Box
The following figure shows the elements that you can brand in the Enter Password
dialog box:
Replace the default product name
with your product name.

Brand the Synchronizing Window
The following figure shows the elements that you can brand in the Synchronizing
window:
Replace the default product name
with your product name.
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Brand the Agent Console
The following figure shows the elements that you can brand in the Agent console:
Replace the default product
name with your product name.

Replace the default
logo with your logo.

Add the “Powered by” logo.
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Branding Options in the User Interface About Window
The following figure shows which elements you can brand in the Agent User
interface About window:
Replace the default product name
with your product name.

Replace the default logo
with your logo.

Add the “Powered by”
logo.
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Brand the Shortcut Menu for the Agent Status Icon
You can configure Agents to show the Agent Status icon. The following figure
shows how you can brand the shortcut menu for the icon:
Replace the default product name
with your product name.

Branding Options for Support Center
You can brand the following Support Center elements:


Logon page



Change Password dialog box



Support Center interface

Inherited Branding
When you brand a community, all of its subcommunities inherit the branding.
However, you can brand a subcommunity differently than its parent community.
For example, you brand a top-level community to match the corporate branding
standards. You can brand a subcommunity under your top-level community to
match the branding standards of a wholly-owned subsidiary of your enterprise.
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Brand the Support Center Logon Page
The following figure shows which elements you can brand in the Support Center
logon page:
Replace the default logo
with your logo.

Add the “Powered by”
logo.
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Move the copyright statement from the
the center to the right side of the page.
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Brand the Change Password Dialog Box
The following figure shows which elements you can brand in the Change
Password dialog box:
Replace the default product image
with your product image.

Add the “Powered by” logo.
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Brand the Support Center Interface
The following figure shows which elements you can brand in Support Center:

Replace the default logo
with your logo.
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Branding Options for the Account Management
Website
You can brand the following elements in the Account Management Website:


Logos



Website name

The following figure shows which elements you can brand in the Account
Management Website:

Replace the default logo with
your logo.
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Brand Product Components
This section explains how to brand Connected Backup product components. It
also describes the requirements for branding graphic elements.

Requirements for Agent Graphics
The following table lists the requirements for each graphic element that you can
brand:
Branded graphic element

Requirements

Product logo in the Agent User interface
(includes the About window)

Format: PNG (Portable Network Graphics).
Size: 256 pixels wide by 40 pixels high.
Background: Transparent or white.

Product logo in the Agent splash screen

Format: PNG (Portable Network Graphics).
Size: 522 pixels wide by 74 pixels high.
Background: Transparent or white.

Product logo in the Agent installation
program

Format: JPEG (Joint Photographic Experts
Groups).
Size: 500 pixels wide x 63 pixels high.
Background: White.

Because of different graphic arrangements between Agent versions, do not use
images that you create for version 8.4 and higher Agent installation program
windows for earlier Agent versions. The Support Center Branding page lets you
choose between two images: one for a version 8.4 or higher Agent, and one for
Agents earlier than version 8.4.
For more information, refer to Support Center Help.
If you do not specify an image for the installation program windows, Support
Center applies the default product logo.
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Requirements for Support Center Graphics
The following table lists the requirements for each graphic element that you can
brand in the Support Center application:
Branded graphic element

Requirements

Product logo in Support Center

Format: GIF (Graphics Internet Format).
Size: 159 pixels wide by 40 pixels high.
Background: Transparent or white.
Recommendation: Center the logo within the 159
by 40 pixel image to ensure the appearance is
balanced.

Product logo in the Support Center
logon page

Format: GIF (Graphics Internet Format).
Size: 170 pixels wide by 181 pixels high.
Background: Transparent or white.
Recommendation: Include the phrase, “Support
Center” as part of the image.

Requirements for Account Management Website Graphics
The following table lists the requirements for each graphic element that you can
brand in the Account Management Website:
Branded graphic element

Requirements

Product logo in the Account
Management Website

Format: PNG (Portable Network Graphics).
Size: 356 pixels wide by 69 pixels high.
Background: Transparent or white. For best
results, use white.

Technician Account Requirements
To use the branding feature, use a technician account that has Apply Branding
and Manage Digital Certificates permission enabled.
For more information about setting permissions for technician accounts, refer to
Support Center Help.
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Start the Branding Process
To start the branding process
1. Ensure that you have correctly sized image files for each component that you
want to brand.
The image files for the Agent must be in PNG format. The image files for
Support Center must be in GIF format. The image files for the Account
Management Website must be in PNG format. The Apply Branding page
specifies the format that is required for the elements that you can brand.
2. Log on to Support Center. Use a technician ID that has the Apply Branding
and Manage Digital Certificates permission enabled.
3. If you use central administration to update deployed Agents, disable it until
you verify the appearance of the branded Agents.
For more information, refer to Support Center Help.
4. Select what you want to brand, for example, the Data Center node (if you have
permission to gain access to this node), or a community that you want to
brand, or a community with Agent configurations that you want to brand.
5. Click Tools > Apply Branding.
The Apply Branding page opens.
6. Enter the required information and click Apply.
Support Center displays the following message:
Community Successfully Branded. New branding settings
were applied to the community. Any subcommunities without
customized branding will use this community's branding.
The dctomcat service can now be restarted to see any
changes to Account Management branding, otherwise
branding changes will refresh automatically in five
minutes.
7. To close the message, click OK.
For more information about how to use the Apply Branding page, refer to
Support Center Help.
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NOTE To brand Agents that are already deployed, you must perform one
of the following procedures:
 Use Support Center to enable Central Administration. When you
change the branding of an Agent community, the next time an Agent in
the community synchronizes with the Data Center during a backup,
the Agent receives the new branding. For more information, see
Installing Agents.
 Use the Agent Installation command-line interface to upgrade Agents
with an Agent Setup file that contains new branding. For more
information, refer to Installing Agents.

Gain Access to Branding Communities
If you brand Support Center at the Data Center level (if you host your Data
Center), log on to Support Center to view your customized branding.
If you brand a community, use the URL for the branded community to view your
customized branding. Support Center displays this URL after you brand a
community and at the top of the Apply Branding page.

NOTE Log on to Support Center as technician for the community that
you want to brand, and not as a technician for the root community.
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Deploy the Account
Management Website

CHAPTER 7

This chapter explains how to deploy and use the standard Account Management
Website. If you plan to create a custom Website, refer to Account Management
Web Services Development.


Overview of the Account Management Website



Deploy the Account Management Website



Logon Credentials



Account Management Website Interface



MyRoam

Overview of the Account Management Website
The Account Management Website lets users download Agent Setup files,
manage their account information, retrieve files (if you use Support Center to
enable MyRoam), or order backed-up files on media such as CDs or DVDs when
they work from a computer that does not host an Agent.
If you use Legacy PC Agents, you can use the Account Management Website
only to retrieve files. When users log on to the website, they can gain access to
MyRoam, but only if you enable it.
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Connected Backup has two types of Account Management Websites:


Standard Account Management Website. If you manage your Data Center, you
install the standard Account Management Website when you install the Data Center
and Support Center software.



Custom Account Management Website. You use the Account Management
Web Services and your development tools to create a custom Website. For
more information, refer to Account Management Web Services Development.

If you use a Data Center that another company manages, they must provide you
with the URL to gain access to the Account Management Website.

NOTE The URLs for the Account Management Website are
case-sensitive.

The standard Account Management Website includes the following features:


Account registration



Agent software downloads



Profile editing, including user password reset



Connection to the MyRoam application for file retrieval



Ability to order account images on CDs or DVDs



Reinstallation of Agent software for account recovery

Deploy the Account Management Website
To deploy the Account Management Website
1. Install the Data Center software on the primary Data Center server.
For more information, refer to Installing the Data Center.
2. Designate a server to host the Account Management Website software.
For more information about system requirements, refer to Installing the Data
Center.
3. To install the standard Account Management Website on the designated
server, run Data Center Setup and select Install Website with MyRoam.
For more information, refer to Installing the Data Center.
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For more information about creating a customized Website, refer to Account
Management Web Services Development.
4. If necessary, edit the terms of use and privacy statements in the Website.
5. Create Agent configurations in Support Center.
For more information, see “Create Agent Configurations” on page 57.
6. If necessary, set the default URL for the Registration and Logon pages.
7. Distribute the Registration URL for the Website to users.
Support Center displays this URL on the Edit Agent Configurations page in the
PC Configurations node. When users go to this URL, they can register an
account and download the Agent software.

NOTE The URLs for the Account Management Website are
case-sensitive.

Ensure Security
When a user connects to the Account Management Website through a Web
browser and receives account information, the Web browser transmits the user’s
password to the Web server unencrypted. Therefore, ensure that your Web server
is secure unless you restrict Web access to a private network.

Edit the Terms of Use and Privacy Pages
By default, the Terms of Use and Privacy links in the generic Account
Management Website display content. If you host your Website, change the terms
to meet the legal requirements of your company.
To edit the Terms of Use and Privacy statement
1. Log on to the server where you installed the standard Account Management
Website.
2. Go to the following folder:
\Datacenter\<apache_tomcat>\webapps\ssws\common

where <apache_tomcat> is the name of the folder that contains the Apache
Tomcat software
3. Use any HTML or text editor to edit the following files:
 policy.html. This page contains the privacy statement content.
 terms.html. This page contains the terms of use content.
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Set the Default URL for Registration and Log On
When you create Agent configurations and Profile and Website settings in
Support Center, Support Center generates URLs for the Account Management
Website Registration and Logon pages. Whether these URLs are resolvable
names depends on your network settings. You can use Data Center Management
Console (DCMC) to set the protocol, computer name, and domain name portions
of the URL.
For more information about how to set the URL, refer to DCMC Help.

Set up User Access
Users open the Account Management Website in the following ways:


Enter the Logon URL of the Website in a Web browser.
After you install the Account Management Website, send the URL of the
Website to your users. Support Center displays the default Logon URL in the
General page of the Profile and Website Settings. You can use the default
URL or you can specify a URL of a different Web server.

NOTE The URLs for the Account Management Website are
case-sensitive.



In the Agent User interface, click Tools > Account Online.
To enable this option, configure the Agent to allow access to the Account
Management Website from the Agent User interface.



When you migrate an Agent to version 8.x, on the Agent Successful
Installation or Upgrade window, click the link to the Account Management
Website.

To log on to the Account Management Website, users must enter the e-mail
address and password in their user profiles. For more information, see “Logon
Credentials” on page 103.

Set up Technician Access
Technicians can gain access to the Account Management Website from the
Account Summary page in Support Center. When technicians click the link to the
Account Management Website from the Account Summary page, they log on as
the account user and can use the same features as the user. Only technicians
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with permission to access users’ data have access to the link. For more
information about how to specify technician permissions, see Support Center
Help.

Logon Credentials
During registration, the Account Management Website prompts users to enter an
e-mail address and password. The Account Management Website adds this
information to the user’s profile. To gain access to their account information on the
Account Management Website, users must enter this e-mail address and
password.
NOTE If the user registers an account within a community that uses
enterprise directory mappings, during registration, the Account
Management Website obtains the user’s email address and password
from the enterprise directory instead of prompting the user for the
information.

Users can specify the same logon credentials for more than one account. If they
use the same logon credentials, the standard Account Management Website
prompts users to select the account to which they want to gain access after they
log on. Users can log on to and view only one account at a time.

Legacy PC Agent Accounts
Users that have Legacy PC Agents do not always have e-mail addresses and
passwords associated with their accounts. When you upgrade these Agents, the
upgrade process assigns logon credentials to the account as follows:


If the Legacy PC account has no e-mail address or password associated with
it, the upgrade process assigns the account number as a temporary e-mail
address, and it assigns the account encryption key as the temporary
password.



If the Legacy PC account has an e-mail address but no password associated
with it, the upgrade process assigns the account encryption key as the
temporary password. Users can enter the Legacy PC account e-mail address
or their account number as the e-mail address. They must enter the account
encryption key as the password.



If the Legacy PC account has a password associated with it but no e-mail
address, the upgrade process assigns the account number as the temporary
e-mail address. Users can enter their Legacy PC account password or the
account encryption key as the password.
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NOTE The temporary e-mail addresses and passwords that the upgrade
process assigns to an upgraded account do not expire.

Logon Credential Management
Users can log on to the Account Management Website and edit their profiles to
change their logon credentials.
NOTE If users register an account in a community that is mapped to an
enterprise directory, they cannot use the Account Management Website
to edit their credentials. Users must edit the values in the enterprise
directory.

Technicians can use Support Center to reset passwords and change the e-mail
address that is associated with an account. For more information about how to
edit profiles, see Account Management Website Help. For more information about
how to set passwords and change the contact information, refer to Support Center
Help.

Account Management Website Interface
The standard Account Management Website displays the following Web pages:


Welcome



Registration



Logon



Summary

Because you can customize any page in the web site, your website might be
different from the examples in this section.
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Welcome Page
The following figure shows the Welcome page that users see when they open the
Account Management Registration URL:
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Registration Page
The following figure shows the Registration page that users see when they start
the registration process:
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Logon Page
The following figure shows the Logon page that users see when they enter the
Account Management Website Logon URL after they register and install an
account:
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Summary Page
The following figure shows the Summary page that users see after they log on to
the Account Management Website:
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MyRoam
MyRoam lets users retrieve backed-up files to any computer without using the
Agent User interface. Users must log on to the Account Management Website to
have access to MyRoam. After users select the files that they want to retrieve, the
Data Center creates a ZIP archive file that contains the selected files. Users
download this file and extract it to a location on their computer.
NOTE Users cannot retrieve files if the ZIP archive file is larger than 2
GB. If MyRoam determines that the ZIP will be larger than 2 GB, it
prompts the user to clear some files from the retrieval set and try to
retrieve files again.

MyRoam cannot retrieve e-mail files backed up by an Agent that
uses EmailOptimizer.
To access MyRoam, users must log on to the Account Management Website.

License and Permission Requirements
To let users use MyRoam, enable MyRoam in the Support Center. You can enable
MyRoam in your top-level community. You also can enable or disable MyRoam in
individual subcommunities and for individual accounts.
You can enable MyRoam in one or more communities under the following
conditions:


If you host your Data Center, you need to install a license for MyRoam on the
Data Center server. If your current license file does not include MyRoam,
contact your sales representative to buy this license.



To enable the MyRoam feature in a community, your technician account must
have Permission to Allocate Licenses to Sub-communities enabled.



To enable MyRoam for specific Agent configurations, your technician account
must have Modify Agent Configuration enabled.

MyRoam Installation
The MyRoam installation is part of the Account Management Website installation.
To install MyRoam, run Data Center Setup and select Install Website with
MyRoam. For information on how to install software on the Data Center server,
refer to Installing the Data Center.
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Enable MyRoam
You must enable MyRoam for each community and each configuration in the
community that needs access to this feature.
To enable MyRoam
1. Log on to Support Center. Use a technician ID that has the Allocate Licenses
to Sub-Communities and Modify Agent Configurations permissions enabled.
2. Select the community where you want to enable MyRoam.
3. On the Community Status page, click Manage Features.
4. On the Manage Features page, locate the row for the MyRoam feature and in
the Settings column, click Enabled.
5. Click Save.
6. Expand the Configurations node.
7. Expand the Profile and Website Settings node and select the configuration
for which you want to enable MyRoam.
The Edit Profile and Website Settings - General page opens.
8. Select Options.
The Edit Profile and Website Settings - Options page opens.
9. In the Account Management Options section, select Allow end users to
retrieve files using MyRoam.
10. Click Finish.

Enable MyRoam for Individual Accounts
After you enable MyRoam at the community and configuration level, you can
enable it for individual accounts or account groups.
To enable MyRoam for one or more accounts
1. Log on to Support Center. Use a technician ID that has the Modify Agent
Configurations permissions enabled.
2. Search for an account or create an account group.
3. Select Tools > Change MyRoam State.
4. Select the check box to enable MyRoam, and click Save.
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CHAPTER 8

This chapter explains the interfaces that you can use to install and configure
Agents.


Overview of the Agent Interfaces



Agent Startup Wizard



Agent User Interface



Agent Command-line Interface
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Overview of the Agent Interfaces
The Agent includes the following interfaces:
Agent Startup Wizard

A graphical interface that opens when users start their Agents
for the first time installation. For more information, see “Agent
Startup Wizard” on page 113.

Agent User interface

A graphical interface that you use to perform the following
tasks:
 View a summary of the most recent backup results and the
configured backup schedule.
 View and specify files in the backup set. The backup set
contains the files you selected for back up.
 View and add rules to the Agent rule set.
 Retrieve files that the Agent previously backed up.
 Recover a system, if the Agent is configured for this
feature.
 View a history of Agent events and operations.
For more information, see “Agent User Interface” on page 115.

Installation
command-line
interface

A command-line interface that you use to perform the
following tasks:
 Install an Agent
 Remove an Agent
 Recover an Agent
 Upgrade an Agent
For more information, refer to Installing PC Agents.

Agent command-line
interface

A command-line interface that you use to perform the
following tasks:
 Back up files
 Retrieve files
 Activate Agents
 Update account profiles
For more information, see “Agent Command-line Interface” on
page 119.
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Agent Startup Wizard
The Agent Startup Wizard is a graphical interface that, if enabled, guides users
through set up of Agent accounts. The Agent Startup Wizard opens under the
following circumstances:


Users start an Agent for the first time after installation.
The Support Center technician must enable the Agent Startup Wizard. For
more information, refer to Support Center Help.



Users start an Agent from a disk image.
The technician who creates the disk image must create one with a running
service. For more information, refer to Installing PC Agents.

Support Center technicians enable the Agent Startup Wizard. For more
information, refer to Support Center Help.
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The following figure describes the Startup Wizard:
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Agent User Interface
You use the Agent user interface to perform the following tasks:


View a summary of the most recent backup results and the configured backup
schedule.



View and specify files in the backup set. The backup set contains the files you
selected for back up.



View and add rules to the Agent rule set.



Retrieve files that the Agent previously backed up.



Recover a system, if the Agent is configured for this feature.



View a history of Agent events and operations.
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Agent Main Window
The following figure shows the main window that the Agent displays when you
open the Agent:
File
menu
Tools
menu

Help

Help
menu

Tabs
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Agent User Interface Components
The following table describes the components of the Agent user interface.
Component

Description

Tabs

 Summary. Displays a summary of the results of the last backup
and the backup schedule.
 Backup Set. Lists the files that the Agent selects for backup. You
can select or clear files in this tab.
 Retrieve. Displays a list of files that you can retrieve. You can
select one or more files for retrieval.
 History. Displays event messages.
For more information, see the online Help for each tab.

File Menu

 Back Up Now. Lets you start a back up manually. The Agent
backs up all new or changed files in the back up set.
 Exit. Closes the Agent User interface.

Tools Menu

 Backup Schedule. If you configure the Agent to let users edit the
backup schedule, this option lets users change the dates and
times when backups occur.
 Advanced Rules. If you configure the Agent to let users edit the
backup set, this option lets users select options in the Backup
Set tab.
 Edit Profile. If you configure the Agent to let users update their
profiles, this option lets users enter information in the Edit Profile
window.
 Manage Account Online. If you configure the Agent to include
this link, the link lets users gain access to their account
information in the Account Management Website from the Agent
User interface.
 Options. If you configure the Agent to let users change backup
options, this option lets users perform backups over dial-up
connections and change the backup mode (passive or
aggressive). For more information about backup modes, see
Support Center Help.

Help Menu

 Connected® Backup/PC Help. Displays a list of available help
topics.
 About Connected® Backup/PC Agent. Displays information
about the installed Agent software. It also displays the account
number associated with the Agent.

Help buttons

®
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Use the Agent User Interface
The following table explains how to use the Agent user interface:
Goal

Action

Select an Agent function

Click the appropriate tab to perform the following tasks:
 Select or clear files in the backup set.
 Retrieve files.
 View the Agent History of events.
 View a summary of the most recent backup.

Gain access to online help

To open the Agent help, on the Agent main menu, click
Help > Connected® Backup/PC Help.
For information about an open tab or window, click the
question mark (?) in the tab or window.

Agent Command-line Interface
When you install the Agent software, Agent Setup program also installs the Agent
command-line interface. You can use the Agent command-line interface to
perform the following tasks:
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Activate Connected Backup Agents from a disk image.



Back up files.



Retrieve files that the Agent previously backed up.



Get Agent configuration data.
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The following table lists the commands that you can use and where to find
additional information about them.
Command

Purpose

Reference

Activate.exe

Activates an Agent that an
administrator installed from a
disk image.

Installing PC Agents

backup.exe

Initiates an unscheduled
backup. This command is
similar to using Backup Now in
the Agent User interface.

“File Backup” on page 121

retrieve.exe

Retrieves one or more files from
the Data Center or from an
account image.

“File Retrieval” on page 137

UpdateProfile.exe

Updates registration fields
according to settings that you
specify in an XML file.

“Use the Updateprofile
Command” on page 119

The commands and parameters are not case-sensitive.

Use the UpdateProfile.exe Command
The UpdateProfile.exe command causes the Agent to update the registration
information stored on the Data Center server with information that you specify in
an XML file.
The UpdateProfile.exe command uses the following syntax:
UpdateProfile.exe -f[ile] filename

Where filename is the full path name to the XML file that contains registration
information.
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The following table describes the parameter that UpdateProfile.exe uses:
Parameter

Syntax/Description

-f [ile]

(Required)
Specifies the path name of an XML file that you create.
Examples:
UpdateProfile.exe -f "c:\filename.xml"
Where
filename is the name of the XML file that contains registration information.
The following example shows how you can use the UpdateProfile.exe
command after you recover an account:
msiexec /qn /i AgentSetup.msi
ACCOUNTNUMBER=account_number TECHID=technician_id
PASSWORD=technician_password
UpdateProfile.exe -f "c:\filename.xml"

For more information on the required fields and the maximum character length for
each field in the XML file, refer to Installing PC Agents.
The UpdateProfile.exe command requires all of the registration fields.
If you do not specify information for a registration field (for example, you specify
<EmployeeID></EmployeeID>), UpdateProfile.exe clears the field in the Data
Center database.

NOTE The UpdateProfile.exe command overwrites changes that you
make to these fields with the Support Center.
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CHAPTER 9

This chapter explains the process that the Agent uses to upload data from a PC to
the Data Center. It also describes the backup settings in Agent configurations.


The Backup Process



Connected EmailOptimizer Information



Back up Encrypted Files, Metadata, and Attributes



Backup Settings

The Backup Process
The following actions occur during the backup process:
1. The Agent scans the host computer’s hard disk and creates a list of files
eligible for backup.
2. The Agent analyzes the file list to identify any new files or files that have
changed since the last backup.
3. The Agent connects to the Data Center.
4. The Agent transmits files to the Data Center.
5. The Agent records the results of the backup.
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Disk Scan
When the Agent initiates a backup, either in response to a user request or
according to its backup schedule, the Agent scans files on disk drive volumes.
The scan excludes removable or network share drives.
If you use the Agent rule set to exclude specific drives, the Agent does not scan
those drives. If you exclude drives that have files that you do not need to back up,
you reduce the amount of time that is required to back up a computer.
The scan creates a list of the files that are on the computer. The Agent uses the
rules in its rule set to determine which files to select for backup. The backup set
for the Agent contains all of the selected files in the list.
NOTE The next backup requires a scan of the entire hard disk under the
following circumstances:
 You restart the Agent service or the Agent computer.
 The Agent rule set changes.
 The components of the backup set change.
 The files in the backup set have 90,000 or more changes for backup.

File Analysis
During analysis, the Agent reviews the list of files it compiled during the scan and
determines whether each file is new, modified, or an exact duplicate of another file
on the computer. It also determines whether the user deleted any previously
backed-up files. The Agent then performs the actions described in the following
table:
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File type

Actions

Base

The file is new, and the Agent backed up the file in its entirety. The
Agent sends the entire file for back up and designates it as a base file.

Deleted Files

The Agent uses file synchronization to notify the Data Center if a user
deleted a previously backed-up file. The Data Center deletes the file
after the file expiration rules determine whether the Data Center
retains a file in storage.

DeltaBlock

The Agent backs up a modified file from the base file data and saves
that file as a delta file.

MDATE

The Agent checks a file modification date (MDATE), size, directory
path, and security descriptors to determine whether a file has changed
since the last backup session.
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File type

Actions

Compound
Mail File

Microsoft Outlook® and Lotus Notes® store email messages for a user
in a single *.pst or *.nsf file. If you use the optional Connected
EmailOptimizer® feature, the Agent can decompile the mail files. This
action enables the Agent to analyze attachments during backup and
apply the DeltaBlock and SendOnce technologies to individual mail
folders and attachments. If you use Connected EmailOptimizer, you
can reduce the amount of disk space on the Data Center required to
store duplicate attachments.

SendOnce

If the file has been backed up previously, the Agent does not back up
this file because at least one other account has already backed up the
same file. SendOnce® Technology prevents multiple copies a file from
being stored on the Data Center.

Size

The original size of the file in KB, MB, or GB before the Agent applied
SendOnce, Delta Block, or compression.

Symbolic Link

If the file is a duplicate of another file. The Agent designates a
symbolic link to the duplicate file and does not send the file contents.

Touch

The Agent backs up only changes to the file attributes because the
data remained the same.

Modified File Identification
The Agent backs up only new files and the portions of files that changed since the
last backup. This process ensures complete protection of the files and reduces
use of disk space on the Data Center. To determine whether a file changed since
the last backup session, the Agent checks the file’s modification date (MDATE),
size, directory path, and security descriptors.
The Agent determines which portions of the file changed by comparing the digital
signature of the file with that of the version on the Data Center. The Agent backs
up only the changed portions, or deltas, of these files.

Modified Mail File Identification
Microsoft Outlook® and Lotus Notes® store user’s e-mail messages in a single
*.pst or *.nsf file. If you use optional Connected EmailOptimizer™, the Agent
can decompile the mail files. This action enables the Agent to analyze
attachments during backup and apply DeltaBlock and SendOnce to individual mail
folders and attachments. If you use the Connected EmailOptimizer feature, you
substantially reduce the amount of disk space on the Data Center required to
store duplicate attachments.
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If you do not use the Connected EmailOptimizer, the Agent cannot analyze the
contents of individual messages and file attachments to identify changes or
determine whether the attached files already exist in the SendOnce pool on the
Data Center. As a result, new attachments received since the last backup are
sent, in their entirety, to the Data Center for backup.
For a description of EmailOptimizer, refer to Product Overview.
.

File Preparation
The Agent compresses and encrypts file data before it transmits the data to the
Data Center. It uses the ZLIB compression library to compress both base and
delta file data and then uses the encryption method that you specified when you
registered the Agent to encrypt the data.

Connection to the Data Center
The following actions occur when the Agent connects to the Data Center:
1. The Agent uses a network connection to connect to the Data Center. When
the Agent contacts the Data Center, the Agent account number identifies the
Agent.
2. After the Data Center authorizes the connection, the Data Center creates an
empty archive for the account and waits to receive files from the Agent.
3. While the Data Center waits to receive files, it downloads a list of expired files
to the Agent.
4. The Agent records the file expirations in a local database on the client.
5. The Agent also checks the Data Center to determine which file sets for backup
already exist in the SendOnce pool.
If an exact copy of a file exists in the SendOnce pool, the Agent does not send
the file’s content to the Data Center. Instead, it sends information about the file
name and location. The Agent and Data Center can use this information at a
later time to retrieve the file content from the SendOnce pool to restore the
client’s copy of the file.
NOTE The Agent initiates connections between the client and the Data
Center server. The Data Center never initiates contact with the Agent
client. Even when a technician uses Support Center to modify an Agent
configuration, the Data Center downloads the changes only after the
Agent connects to the Data Center.
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Transmission of Files
After the Agent connects to the Data Center, it initiates a backup session. The
backup consists of the following tasks:
1. The Agent transmits the digital signature of the file to the Data Center. The
Data Center compares this signature with other files in its database. If an
identical file exists in its database, the Data Center creates a pointer to the file
in the SendOnce pool when it creates the archive for the backup. The Agent
does not transmit the file to the Data Center.
2. If the SendOnce does not contain the file, the Agent uses the ZLIB
compression library to compress the file.
3. The Agent uses an encryption key to encrypt the file. The Agent generates the
encryption key. You cannot view this key.
4. The Agent transmits the compressed and encrypted file to the Data Center.
5. As the Data Center receives the files, it puts them into archives.
For more information, refer to the Product Overview guide.

Record of Backup Results
The Data Center transmits an acknowledgement (ACK) or non-acknowledgement
(NACK) for each file that it receives or fails to receive from the Agent. The Agent
uses these receipts to update the Agent database. To view the results of the
backup, view the Agent History in the Agent User interface or Support Center.
NOTE If a backup fails because of a power outage, or a backup service
fails unexpectedly, the Agent History indicates the failure but does not
provide details.

Connected EmailOptimizer Information
If you use Connected EmailOptimizer to back up your mail files, the decompile
process creates smaller constituent files on your computer that contain parts of
the mail file. By default, Connected EmailOptimizer stores these constituent files
in the following locations, based on Agent version and the type of operating
system on your computer:
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Version

Location

7.x versions before
7.5.3 update 6

Mail folder resides in the Connected Backup installation folder,
by default: [$systemdrive]\Program Files\
Connected\Mail

7.5.3 update 6 and
later

[$systemdrive]\Documents and Settings\All
Users\Application Data\Email Backup
Optimization\Data\Mail

8.x versions before
8.2.0

Mail folder resides in the Connected Backup installation folder,
by default: [$systemdrive]\Program Files\Iron
Mountain\Connected BackupPC\Mail

8.2.0 to 8.2.0.4

In a subfolder beneath the current location of the mail file, with
the same name as the backed up mail file.

8.2.1 and later

[$systemdrive]\Documents and Settings\All
Users\Application Data\Email Backup
Optimization\Data\Mail

8.2.2 and later
(Windows Vista)

[$systemdrive]\ProgramData\Email Backup
Optimization\Data\Mail

8.4.0 and later
(Windows 7)

[$systemdrive]\ProgramData\Email Backup
Optimization\Data\Mail

You can configure the version 8.5 or later Connected EmailOptimizer to store the
constituent files that pertain to a backed-up mail file to a folder other than the
default folder.
To change the folder that Connected EmailOptimizer uses to store and process
mail files, modify the appropriate Windows registry key for the Agent computer
operating system:


Windows 32-bit
HKEY_LOCAL_MACHINE\SOFTWARE\Connected\Agent\Mail



Windows 64-bit
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Connected\Agent\Mail
NOTE If you change this Windows registry key for an Agent that has
previously backed up files using the Connected EmailOptimizer, the
Agent leaves any previous constituent files in the default local folder. You
must remove the Connected EmailOptimizer constituent files manually
from the default local folder.
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If you uninstall an Agent that uses this Windows registry key, you must remove the
Connected EmailOptimizer files manually from the specified folder.

Back up Encrypted Files, Metadata, and Attributes
You can back up the following types of files:
Data

Description

Encrypted files

The Agent backs up encrypted files using SendOnce® and Delta
Block®. You must configure your system to use the NTFS file
system when you back up encrypted files.
For encrypted files, the Agent does not back up multiple data
streams, reparse points, extended attributes, sparse files, or shared
file attributes.

Multistream files

In the NTFS file system, a stream contains the data written to the
file. In addition, the stream can contain metadata for the file. You
can create files that have multiple data streams associated with
them.
The Agent backs up multistream files. If a file has an Object
Identifier, the Agent omits it from the backup. An Object Identifier is
a type of tag that is sometimes associated with Microsoft Office files.

Open files

The Agent can back up open files and files that are in use by an
application at the time of backup. The Agent uses Microsoft Volume
Shadow Copy Service (VSS) for open file backup. If the Agent
cannot connect to the open file, the Agent generates an event in
Agent History and does not back up the file.
For more information about requirements for backing up open files,
see “Backup Settings” on page 129.

Reparse points

A reparse point is a collection of metadata that an application stores
with a file or directory that it creates. Reparse points have an
association with an application-specific filter.
When a user opens a file or directory, the file system passes the
metadata to the application-specific filter. The filter processes the
data in the reparse point and performs the specified action.
Examples of reparse points include symbolic links and Volume
Mount Points.
The Agent backs up the metadata for all reparse points except for
Volume Mount Points.
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Data

Description

Security
descriptors

Security descriptors prevent unauthorized access to files. Security
descriptors include information such as the following:
 Owner of the file
 Permissions the owner has granted to other users
 Actions that the file system logs for auditing purposes.
If a security descriptor for a file or folder changes, the Agent
considers the file or directory to be different from the previous
version and backs up the security descriptors for the file or folder.
The Agent backs up file content only if the Agent determines that, in
addition to the security descriptors, the content changed.

Sparse files

Sparse files contain empty spaces (represented as strings of zeros)
along with meaningful data (nonzero data). The file system
allocates disk space for the meaningful data but does not allocate
space for the nonmeaningful data (the strings of zeros). The file
system tracks where the nonmeaningful data belongs. When an
application retrieves a file, the Agent can retrieve the data and the
strings of zeros.
The Agent backs up all allocated blocks in a sparse file. It does not
back up the unallocated block. When an application connects to the
file, the correct data is available.

CAUTION Do not include the Time Machine folder in your backup set. If
you do, the backup process uses all available memory.
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Backup Settings
When you use Support Center to create or modify an Agent, you select
backup settings that suit the unique needs of your users. The following table
describes the backup settings:
Backup Settings

Descriptions

Backup messages

You can use the following settings to configure Agents to
manage messages related to backups:
 If the Agent is closed before automatic backup starts, prompt
the user to delay, start or cancel the backup.
 If the Agent is closed, show backup outcome as a popup
message.
 Show a warning if there has been no successful backup in 4
days.

Agent visibility

You can use the following settings to display information on the
Agent window:
 Show the splash screen during system startup.
 Show the Agent Status icon in the taskbar notification area.

Connected
EmailOptimizer
password prompt
(PC Agents only)

For accounts with Connected EmailOptimizer, you can select
how the PC Agent prompts users for email passwords during a
backup. Select one of the following options:
 Prompt for the password for one minute. If the user cancels
or does not reply to this prompt, back up the Lotus Notes or
Microsoft Outlook file without optimization.
 Prompt for the password until the user responds. If the user
cancels this prompt, do not back up the Lotus Notes or
Microsoft Outlook file.
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Backup Settings

Descriptions

Backup mode

You can specify one of the following backup modes:
 Passive. The Agent does not retry backups that cannot start
because of the following conditions:
 Errors.
 The Agent is busy doing a retrieval.
 The computer cannot connect to the Data Center.
Under these circumstances, the Agent waits for the next
scheduled backup, or for a user to initiate a manual backup.
 Aggressive. The Agent retries backup periodically until a
successful backup occurs. If a backup attempt generates
warnings or errors, the Agent does not retry backup.

Backup limits

You can limit the size of the backup set for each Agent
configuration.
You can limit the size of backups in the following ways:
 On the Agent computer, set a size limit of the backup set in
megabytes or gigabytes. For example, you can set the
backup set size limit to 30 GB.
 Configure the Agent to display a warning message when the
backup set reaches a specified percentage of its limit. For
example, you can configure the Agent to display a warning
when the backup set size is 90% of the allowed size limit.
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Backup Settings

Descriptions

Backup permissions

You can configure Agents to let users have the following
permissions:
 Modify their backup sets. If you enable this permission,
users have access to user-configurable backup options such
as the backup mode settings.
 Allow backup over dial-up connections.
 Let users edit their backup schedules in the Agent User
interface.

Backup schedule

You can select one of the following backup schedules:
 Automatic on specific days and times (default). Starts a
backup during the same time period each day. For example,
the Agent can perform a backup each night between
midnight and 6:00 A.M. You can select only a range of time
and not an exact time for the backup. The Agent determines
when to perform the backup within the range that you
specify. This behavior balances network traffic.
 Manual backup. Starts a backup only when a user initiates
it.

Agent rule sets

To determine which files to select for backup, create rule sets.
To create rule sets, use the Agent Rules wizard in Support
Center.
New Agent installations include configured rules. If you change
the rules, the Agent receives the changes the next time that it
connects to the Data Center.
Users can create rules that override some rules in an Agent’s
default rule set. You can create overriding rules in the following
ways:
 Select or remove files on the Backup Set tab in the Agent
User interface.
 Use the Advanced Rules option to create rules.
For both options, users must have permission to modify their
backup sets, which you set in the Agent Settings component
associated with the Agent configuration.
For more information about rule sets, see “Create Agent Rule
Sets” on page 65. For more information about how to create
rules, refer to Support Center Help.
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Use the Agent User Interface to Back Up Files
You can use the Agent User interface to start a backup manually, specify which
files are in the backup set, or monitor a backup in progress.
The Agent configuration that you create in Support Center determines how the
Agent backs up data. The configuration includes all of the backup settings and
versions for the Agent.
For more information about how to create Agent configurations, refer to Support
Center Help. For more information about how to use the Agent command-line
interface for backups, see “Back Up Files Using the Backup Command” on
page 135 and refer to Agent Help.
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Backup Set Tab
You can use the Backup Set tab to change the file selection for the backup set or
start a backup manually. For more information, refer to Agent Help.
The following figure shows the Backup Set tab:

Select or deselect files

Status bar shows
size of backup set
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Summary Tab
You can use the Summary tab to start a backup and view History details about the
last backup that the Agent performed.
The following figure shows the Summary tab:
Click this link to view backup
history details.

View backup and informational
messages.
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Backup Monitoring
If you configure the Agent to use a predetermined schedule, you do not need
to open the Agent User interface. The Agent scans the system’s hard disk and
identifies which files to back up.
If you want to monitor progress of a backup, open the Agent User interface
while the backup is in progress. The Agent displays a progress window that
indicates the state of the backup. The Agent disables all other tabs and
options. You can check the Agent history to determine the outcome of a
backup that is complete.
The following figure shows the Agent User interface while a backup is in
progress:

Back Up Files Using the Backup Command
Rather than wait for a scheduled backup, you can use the Backup command from
the Agent command-line interface to start a backup. This command is equivalent
to Backup Now in the Agent User interface.
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The Backup command backs up files based on the backup settings in the Agent
configuration. You cannot use the Backup command to specify a specific file for
backup.
Also use the Backup command if you use scripts to automate computer
management or if you must manage computers from remote locations.
For more information about how to gain access to the Agent command line
interface, see “Agent Interfaces” on page 111.

Requirements for Backing Up Open Files
The Agent can back up files that are open when the backup runs. To ensure that
the Agent can back up open files, you need 20% of available disk space on each
drive that the Agent backs up. The backup event in Agent History indicates
whether the Agent was able to back up open files.

Backup Command Syntax
The backup command uses the following syntax:
backup.exe
[{-firstbackup | -b}]
[{-help | -?}]

Backup Command Switches
The Backup command uses the following optional switches:
Switch

Description

[{-firstbackup | - b}]

Initiates a first backup after you install the Agent.

[{-help | -?}]

Displays online help for the current command.

Backup Command-line Example
The following example is a command that starts the first backup after you install
the Agent.
backup.exe -firstbackup

The Agent uses the rules in its configuration to select files for backup.
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File Retrieval
CHAPTER 10

This chapter explains how to retrieve files from the Data Center and from media.


The Retrieval Process



Support for Encrypted Files, Metadata, and Attributes



Retrieve Files Using the Agent User Interface



Retrieve Files Using the Retrieve Command



Retrieve Data from Media

The Retrieval Process
The following actions occur during the retrieval process:
1. The Agent connects to the Data Center to initiate a retrieval request.
2. The Data Center receives the request and packages files from one or more
archives.
3. The Data Center compresses and encrypts the packaged files, and then
downloads them to the Agent.
4. The Agent decompresses and decrypts the files.
5. The Agent distributes the files to the destination folders, and then applies
conflict resolution rules.
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File Repackaging
Many files that you retrieve have multiple versions backed up on the Data Center.
These backups contain incremental changes, or deltas, that the Data Center
stores in one or more archives.
During a retrieval, the Data Center collects the archives that it needs to
reconstitute the requested version of the files from its server and, if applicable,
from its auxiliary storage devices. The Data Center extracts the required base and
delta files from the archives. It then merges them to create the file or files that the
Agent requested. Before the Data Center downloads the files to the Agent, the
Data Center compresses and encrypts the files again for security.

E-mail Notification
You can configure the Data Center to send an e-mail message to the Agent e-mail
address when anyone retrieves files for an account that is registered in a specific
community.
E-mail notification contributes to security. When a technician knows about a file
retrieval, the technician can act appropriately if an unauthorized person retrieves
the files.
You enable e-mail notification through Support Center at the Data Center,
community, or subcommunity level. You cannot restrict e-mail notification to
specific Agent configurations. You can enable e-mail notification for the entire
Data Center or specific communities. For more information about how to enable
e-mail notification, refer to Support Center Help.

Support for Encrypted Files, Metadata, and Attributes
This section describes how Connected Backup supports encrypted files,
metadata, and attributes during file retrievals.

Retrieval of Encrypted Files
To retrieve an encrypted file, you need access permissions to the encrypted file.
You also must use a system that is configured to use the NTFS file system.
If you retrieve files that were encrypted by a third-party application before you
backed them up to a folder that is also encrypted by the third party application, the
third-party application encrypts the files after the retrieval process completes.
If you retrieve the encrypted files to a directory that is not encrypted by the
third-party application, the files are not encrypted after the retrieval process
completes.
•
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If you use MyRoam to retrieves the encrypted files, the third party application does
not encrypt the files after the retrieval process completes.

Retrieval of Sparse Files
During a retrieval, the Agent restores sparse files and all allocated sparse data
that was previously backed up.

Retrieval of Multistream Files
Retrieve restores only alternate streams on files. If a folder is missing on the client
system but was previously backed up, you can select this folder for retrieval. The
Agent then retrieves the associated multistream data. Otherwise, you must use
Heal to restore alternate streams on directories.

Retrieval of Reparse Points
A reparse point is a collection of metadata that an application stores with a file or
directory that it creates. During a retrieval, the Agent restores reparse points for
files only. It does not restore reparse points for directories. Remove directory
junctions before you retrieve the directory.
You cannot retrieve Volume Mount Points.

Retrieval of Security Descriptors
When you retrieve a backed up file or directory, the Agent assigns the appropriate
security descriptor to the file or directory.
If the Agent must create a directory to restore a file, and the directory was not
backed up previously (and therefore had no security descriptor assigned to it), the
assigned security descriptor is the default value for the retrieve location. The
security identifier (SID) that Retrieve assigns to the owner field of the security
descriptor is the SID for the user performing the retrieve.
If you retrieve a file that did not have a security descriptor when Connected
Backup backed it up, Retrieve assigns the default security descriptor for the
retrieve location to the file. The security identifier (SID) that Retrieve assigns to
the owner field of the security descriptor is the SID for the user performing the
retrieve.

Retrieval of Open Files
The Agent can back up open files and files that are in use by an application at the
time of backup. For more information about backing up open files, see “Back up
Encrypted Files, Metadata, and Attributes” on page 127. You can retrieve the files
that the Agent backed up while they were open.
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If you try to retrieve a file while it is currently open on your system, and you
selected the Overwrite the files currently on my computer option, the Agent
renames the file that it retrieves from the Data Center. When the Agent renames
files, it adds a number to the end of the file name.
The Agent also generates an event in Agent History to indicate that it retrieved
and renamed the file.
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Retrieve Files Using the Agent User Interface
When the Agent retrieves files, it uses the Agent account number to authenticate
to the Data Center. The Agent submits the retrieval request to the Data Center
and waits to receive the files. For more information about the Agent User
interface, see “Agent Interfaces” on page 111.

Retrieve Tab
The following figure shows the Retrieve tab with a list of retrievable files.

1. Display file versions

2. Select files to retrieve
Click to retrieve files.
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Retrieve Permissions
The Retrieve permissions that you set in the Agent configuration determine
whether users need a password to gain access to the Retrieve tab. When you
create Agent settings, you can specify one of the following actions:


Do not require a password to retrieve files.



Require a password to retrieve files. The password is the password
associated with the account. If you upgraded the Agent from a Legacy PC
Agent, the password is the encryption key for the account.

If you configured the Agent to require a password, the Agent prompts the user for
this information before it opens the Retrieve tab.

File Selection
By default, the Agent’s Retrieve tab lists the most recent versions of files that the
Agent created during the last backup. You can also display the files that the Agent
backed up on or before a specified date, or all versions of the files. You can use
these options to retrieve earlier versions of files as well as the most recent ones.
To select files that you want to retrieve, select the check box next to each folder or
file.
For more information about how to select files, refer to Agent Help.

Destination Options
After you select files to retrieve, the Agent displays the Agent Options window. On
the Agent Options window, you can select any of the following options as
destinations for retrieved files:


Save all files in folder. Specifies a specific folder as the destination for
retrieved files. The default destination is My Computer.
If you select Save all files in folder, you can also select Maintain original
folder structure. When you select this option, the Agent creates a file path in
the destination folder that is the same as the file path in the original folder.
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locations. When you select this option, you disable the other destination
options.
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File Name Conflict Options
In addition to using the Agent Options window to select destinations for retrieved
files, you can specify how to rename files in case a file name conflict occurs. You
can choose either of the following options:


Rename the files being retrieved. Renames a file when the destination
folder contains a file with the same name, and adds a number to the end of the
file name when it renames files.
For example, if you retrieve a file named Report.doc and this file exists in
the destination folder, Retrieve would rename the file to Report1.doc. This
option is available only if you select Original Location.



Overwrite the files on my computer. Overwrites files on your computer if the
retrieved files have the same name as existing files. This option is available
only if you select Original Location.

Retrieve Files Using the Retrieve Command
To use the Agent command-line interface to retrieve backed up files from the Data
Center, issue the Retrieve command. After you issue the Retrieve command, the
Agent connects to the Data Center and uses its account number to authenticate.
The Agent submits the retrieval request to the Data Center and waits to receive
files.
If a file that the Agent retrieves has the same name as a file in the destination
folder, the Agent renames the file in the destination folder. For more information
about how to gain access to the Agent command-line interface, see “Agent
Interfaces” on page 111.
Use the Retrieve command in the following situations:


You use scripts to automate computer management or to manage computers
from remote locations.



You want to retrieve file images stored on media.
The Retrieve command is the only way to retrieve files from images stored on
media. For more information about retrieving files from images, see “Retrieve
Data from Media” on page 147.

For more information about performing command-line installations, refer to
Installing PC Agents.
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Retrieve Command Syntax
The Retrieve command uses the following syntax:
retrieve.exe
{-date | -d} YYYY-MM-DD
{-time | -t} HH:MM:SS
(-techid | -id} technician_ID
{-password | -pw} technician_password
[{-destination | -dp} path]
[{-source | -s} source_path | {-alldata | -a}]
[{-norecurse | -nr}]
[{-help | -?}]

Retrieve Command Switches
The Retrieve command uses the following switches:
Switch

Description

{-date | -d} YYYY-MM-DD

(Optional.) The date of the file that you want to
retrieve.
If you do not use -date or -time, the retrieve
command retrieves the most recent version of the
files.
If you use -date with -time, you retrieve files as of the
date and time that you specify.
If you use - date without -time, you retrieve files as of
midnight on the date that you specify.
If you use -date with -time, you retrieve files as of the
date and time that you specify.
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Switch

Description

{-time | -t} HH:MM:SS

(Optional.) The time of the file that you want to
retrieve. Use a 24-hour time format to specify the
time.
If you do not use -date or time, you retrieve the most
recent version of the files.
If you use -time with -date, you retrieve the files as of
midnight on the date that you specify.
If you use -time without -date, you retrieve files as of
the current date and the time that you specify.
If you use -time with -date, you retrieve files as of the
date and time that you specify.

{-techid | -id}
technician_ID

(Required.) A valid Technician ID. The ID must have
permission to gain access to the community in which
the user registered the Agent account.

{-password | -pw}
Technician_password

(Required.) The password associated with the
Technician ID.

[{-destination | -dp}
path]

(Optional.) Specifies where you want to put the
restored files.
Use the following syntax:
drive:\path
If the original drive does not exist, the Retrieve
command creates the following path for the retrieved
files:
@Drive_n\original_filepath
If you do not specify this parameter, the command
restores files to their original locations.
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Switch

Description

[{-source | -s}
source_path |
{-alldata | -a}]

(Optional.) Specifies the files that you want to
retrieve.
You can specify one of the following switches:
 -source | -s:
Specifies the path to the files that you want to
retrieve.
You can use the asterisk (*) and the question mark
(?) as wildcard characters. The * wildcard
matches any combination of characters. The
wildcard matches any single character.
 -alldata | -a:
Retrieves all data from the backup specified in the
-date parameter. This parameter is the default if
you do not specify the -source parameter.

[{-norecurse | -nr}]

(Optional.) Tells the Agent not to retrieve files from
lower level subfolders. Use this switch with the
-source or -s switch

[{-help | -?}]

(Optional.) Displays online help for the Retrieve
command.

Examples of How to Use the Retrieve Command
The following examples show ways that you can use the retrieve command.

Retrieve a Single File
This command retrieves a file named myfile.doc from a backup set. The
example does not specify a date or time. Therefore, the command retrieves the
most recent version of the files. The example does not specify a destination
parameter. Therefore, the command restores the file to its original location.
retrieve.exe -techid supt346 -password 678ioh7 -source c:\
reports\myfile.doc
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Retrieve a Single File and Specify Date and Time
This command retrieves a file named myfile.doc from a backup set with a date
of January 15, 2014 and time of 2:15 a.m. The example does not specify a
destination parameter. Therefore, the command restores the file to its original
location.
retrieve.exe -date 2014-01-15 -time 02:15:00 -techid supt346
-password 678ioh7 
-source c:\reports\myfile.doc

Specify a Retrieve Location
This command retrieves a file named myfile.doc from a backup set with a date
and time of January 15, 2014, 2:15 a.m., and saves the file to a folder named c:\
restore.
retrieve.exe -date 2014-01-15 -time 02:15:00 -techid supt346
-password 678ioh7
-destination c:\restore -source c:\reports\myfile.doc

Retrieve Files Only in a Top-level Folder
This command retrieves files in a folder named c:\reports. In this example, the
NoRecurse parameter indicates that the command does not retrieve files in
subfolders.
retrieve.exe -date 2014-01-15 -time 02:15:00 -techid supt346
-password 678ioh7 
-destination c:\restore -source c:\reports -norecurse

Retrieve All Files in a Backup Set
The command retrieves all files in a backup set with a date and time of January
15, 2014, 2:15 a.m.
retrieve.exe -date 2014-01-15 -time 02:15:00 -techid supt346
-password 678ioh7 
-destination c:\restore -alldata

Retrieve Data from Media
You can retrieve data from images stored on CDs, DVDs, or Network Attached
Storage (NAS) devices. You use this option when the size of a retrieval request
exceeds the capacity of the network connection.
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Technicians use Support Center to order account images on media for users to
retrieve. Alternately, users can order images for themselves through the Account
Management Website. For more information about how to order images on media,
see “Order Media” on page 166. In response to the requests, Technicians use the
DataBundler application to create account images on media.
Account images include a version of the Agent as well as the backed up files. You
retrieve files from media similarly to how you retrieve them in the Agent User
interface. You open the Agent User interface on the media and select files from
the Retrieve tab, or you use the Retrieve command from the command line
interface.
For more information about media, see “Agent Account Images on Media” on
page 165 on page 165. If you host your own Data Center, for more information,
refer to Administering the Data Center and DataBundler Help.

Use the Retrieve Tab to Retrieve Data from Media
To retrieve files from media, use the Retrieve tab on the image stored on the
media.
To use the Retrieve tab to retrieve data
1. Do one of the following:
 If the media is a CD or DVD, insert the disk into the appropriate drive.

If Windows autorun is enabled on the Agent host computer, the Agent
User interface opens. Otherwise, navigate to the device and run the Agent
executable file.
 If the media is a NAS device, use Windows Explorer to navigate to the

device and run the Agent executable file.
2. If the account image is protected by a password, enter the password when the
Agent prompts you to do so.
If you used the Account Management Website to order the media, the
password must match the one that you entered when you submitted the order.
If a technician ordered the media on your behalf, the password must match
the one the technician specified when he or she used Support Center to order
the media.
3. Click the Retrieve tab.
4. Select the files that you want to retrieve, and click Retrieve.
5. Specify a destination for the retrieved files and a conflict resolution option to
handle file naming conflicts.
For more information about how to retrieve files, refer to Agent Help.
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Using the Agent Command-line Interface to Retrieve Data from Media
Use the Retrieve command from Agent command-line interface to retrieve files
from media in the same way that you use the command to retrieve files on an
Agent client.
To use the command-line interface to retrieve files from media
1. Open a command line on the Agent host computer.
2. Navigate to the device where the media is located.
3. Enter the retrieve command and the appropriate parameters to run the Agent
executable file.
For more information about how to use the Retrieve command, see “Retrieve
Files Using the Retrieve Command” on page 143.

Retrieve Data Using MyRoam
MyRoam lets users retrieve backed-up files to any computer without using the
Agent User interface. Users must log on to the Account Management Website to
have access to MyRoam. After users select the files that they want to retrieve, the
Data Center creates a ZIP archive file that contains the selected files. Users
download this file and extract it to a location on their computer.
To use MyRoam, the Agent account and the community where the account is
registered must have MyRoam enabled.

The MyRoam Retrieval Process
The process to retrieve files with the MyRoam application comprises the following
steps:
1. You select a backup set that includes the files that you need.
2. The MyRoam application displays a list of files that you can select for retrieval.
3. You select the files that you want to retrieve.
4. The Data Center server creates a ZIP archive file that contains the files that
you selected.
If you initiate the retrieval from a computer with a different operating system
than the computer on which the Agent account resides, the Data Center
creates a ZIP file that contains only the files that you selected. The ZIP file
does not restore the metadata associated with the files.
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If you initiate the retrieval from a computer that runs the same operating
system as the computer on which the Agent account resides, the Data Center
creates a ZIP file that contains the following files:
 MyRoam_Expander file
 A message file
 A data file

The MyRoam_Expander file is an executable file that restores your files along
with metadata that is associated with the files.
For example, if you use Safari on a Mac computer to download files from an
Agent account on a Windows computer, the Data Center creates a ZIP file that
contains only the files that you selected for retrieval. If you use Safari on a
Mac computer to download files from an Agent account on a Mac computer,
the Data Center creates a ZIP file that contains the files you selected for
retrieval and the MyRoam_Expander executable file.
5. You download the ZIP file to a location of your choice. The ZIP file preserves
the folder structure for the files that you selected. Because the folder structure
remains intact, you do not have to be concerned with file name conflicts as
you would if you were to use the Agent interface to retrieve the files.
6. You extract the contents of the ZIP file, and then double-click
MyRoam_Expander.

NOTE MyRoam has a 2 GB data limit. You cannot zip or unzip a file that
has an uncompressed data size that is more than 2 GB.

Files That You Cannot Retrieve
You can retrieve most backed-up files except for e-mail files that the Agent backed
up with the Connected EmailOptimizer technology. You must use the Agent User
interface to retrieve these files.
You can retrieve encrypted files. However, MyRoam retrieves encrypted files to an
unencrypted state.

NOTE You can retrieve multistream files. However, the MyRoam
application retrieves the main data stream only.
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Select Files for Retrieval
When you select Retrieve files using MyRoam™, the MyRoam application
compiles a list of files that you can retrieve from the Data Center. When the list is
ready, the MyRoam application displays a Browse view that lists the files that your
Agent previously backed up. The default view for this page shows the latest
version of each backed-up file.
To select files for retrieval
1. To find the files that you want to select, use one of the following methods:
 Browse.
 Use a wildcard search.
 Display specific file versions.

2. Select the check box next to each file that you want retrieve.
3. To start the retrieve process, click Retrieve.
To browse for files
1. To find specific files to select for retrieval, expand the folders in the left pane of
the Browse view.
2. To sort the list of files, click any column heading.
An up-arrow in the column heading indicates that the column is sorted in
ascending order. A down-arrow indicates that the column is sorted in
descending order.
To use a wildcard search to find files
1. Click Find.
The MyRoam application displays the Find options.
2. In the Name contains field, enter the full or partial name of the file you want to
find.
The names are not case sensitive.
You can use the following wildcard characters in the name:

®

*

Use this character to match zero or more characters. For example, *.doc
matches any file that has a file extension of .doc.

?

Use this character to match a single character. For example, ab?.doc
matches abc.doc and aby.doc.
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3. In the Look in folder box, enter the full path for a folder that you want to
search, or select a folder in the left pane.
Find searches all folders within the folder that you specify.
TIP The default location for the Look in folder box is the folder
selected in the left pane. To change the folder location, select a
new folder in the left pane.

4. Click Find Next.
In the list below the Find options, the Agent highlights the first file or folder that
it finds.
5. Do one of the following:
 Click Find Next or use the arrow buttons to highlight the next folder or file

that matches the Find criteria.
 Click Find Previous or use the arrow buttons to highlight a previously

found file or folder.
6. From the displayed list, select the file that you want to retrieve.
7. To hide the Find options, click X in the upper right corner of the Find pane, or
click Browse.
In the Show field, the Agent displays the list of files that match the criteria.
To display different file versions
1. To change the file versions that are displayed in the Browse view, select an
option from the Show versions list. The list includes the following options:
 Most Recent. Displays the most recent versions of the backed-up files.

This is the default selection.
 As of Backup Date. Lets you display all versions of backed up files that

were on your system at the time of the selected backup.
 All. Lets you display all versions of the files that are currently stored on the

Data Center server.
2. If you selected As of Backup Date, select a backup date from the displayed
list.
3. Click OK.
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Retrieve Files
After you select the files that you want to retrieve, you are ready to download the
selected files.
To download the selected files
1. In the MyRoam Browse view, click Retrieve.
The MyRoam application displays information about the total size of the files
that you select for retrieval and the estimated download times for each file. It
also includes instructions on how to download the ZIP archive file or Mac
executable file that contains your retrieved files.
2. Select the type of file that you want the Data Center to generate:
 Zip file. Restores data only.

By default, if you initiate the retrieval from a computer with a different
operating system than the computer on which the Agent account resides,
the Data Center creates a ZIP file that contains the files that you selected
for retrieval. The ZIP file does not restore the metadata associated with the
files.
If you initiate the retrieval from a computer with a different operating
system than the computer on which the Agent account resides, do not
select this option.
 Mac executable. Restores data and metadata.

By default, if you use a Mac computer to retrieve files backed up by a Mac
Agent, the Data Center creates a ZIP file that includes the
MyRoam_Expander file. This executable file restores your files along with
metadata that is associated with the files.
3. Click Download.
4. In the File Download box, click Save.
5. In the Save As box, specify a location for the ZIP file, and click Save.
6. Do one of the following:
 If the ZIP file is a standard one that contains the files that you selected for

retrieval, extract the contents of the ZIP file to where you want them on
your local computer.
 If the ZIP file contains the MyRoam_Expander file, extract the contents of

the file to a temporary location, and then double-click
MyRoam_Expander.
The program restores the files to the root of the directory that contains the
MyRoam_Expander file.

®
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To use MyRoam to retrieve files
1. Log on to the Account Management Website:
2. Select Retrieve Files with MyRoam™.
3. Select the files that you want to retrieve and click Retrieve.
The MyRoam application creates a compressed archive file (ZIP file) that
contains all of the selected files.
NOTE MyRoam has a 2 GB data limit for creating zip files. You
cannot zip or unzip a file whose uncompressed data is more than 2
GB.

4. Click Download to download the compressed ZIP file.
For more information, refer to MyRoam Help.
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Heal
This chapter explains how to use the Agent to restore a computer’s files and
registry settings using the data stored during previous backups.


The Heal Process



Restore Encrypted Files, Metadata, and Attributes



Requirements for Using Heal



Use Heal to Restore Files from Media



Use Heal to Restore Files from the Data Center

The Heal Process
Heal is functionality that uses data from previous backups to restore a computer’s
files and registry settings to the configuration that existed on a date that you
specify.
Use Heal in any of the following situations:


An application has ceased to function properly and you cannot determine the
cause of the malfunction.



You changed a computer’s Windows registry settings, and you must restore
them to a previous setting.

®
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The computer’s operating system produces errors or behaves erratically after
a modification or virus infection.



You need to restore the data from a lost computer or a destroyed hard drive to
a new computer.

During Heal, the Agent determines whether you configured the current system
correctly and then identifies files for Heal.
A file is a candidate for Heal if the Agent selects it for backup. If you choose to
exclude data files from Heal, these files are not candidates for Heal, even if the
Agent typically selects them for backups.
The following figure describes the phases in the Heal process.

1

2

The Agent checks for system
compatibility.

The Agent applies rules to files
that are candidates for the Heal
process.

6

5

The Agent deletes files.

The Agent retrieves files.

7

8

The Agent restores disk quotas.

The Agent replaces the registry.

3
The Agent checks available disk
space.

4
The Agent displays preview
information.

9
The Agent restarts the
computer.

Compatibility Verification
The Agent verifies system compatibility.
The current computer must have the following similarities with the computer you
used on the selected Heal date:


The bit platform.
For example, to restore files to a computer that has a 64-bit platform, you must
use a backup from a computer that has a 64-bit platform. To restore files to a
computer that has a 32-bit platform, you must use a backup from a computer
that has a 32-bit platform.
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The service pack must be the same, however Windows updates and security
patches can be different.



The system BIOS is the same.



The video BIOS is the same.



The drive letters corresponding to fixed drives selected for backup are the
same.

Rule Application
The Agent uses its current rules to determine the actions to take for each file that
is a candidate for Heal.
The Agent does one of the following for each file that is a Heal candidate:


Deletes the file. If the file was not present at the Heal date but is currently on
the computer, the Agent deletes it.



Adds the file. If the file was present at the Heal date but is not currently on the
computer, the Agent restores the file.



Replaces the file. If the file currently on the computer was also present at the
Heal date but is different from the original file, the Agent replaces the current
file with the file that existed at the Heal date.



Takes no action. If the file currently on the computer is identical to the file
from the Heal date, the Agent does not modify the current file.

If the current rules exclude a file from backup, the Agent does not modify the
current file.

Disk Space Verification
The Agent ensures that there is sufficient disk space to modify or add files before
it continues with the Heal operation.

Information Preview
The Agent displays a list of files that it will recover and the actions it will take for
each file. You can change the selection of files, if necessary.

File Retrieval
The Agent retrieves files that it must modify or add to the current computer from
the Data Center or the account image.

®
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File Deletion
The Agent deletes files that were not present at the time of the Heal date.

Disk Quota Restoration
The Agent restores disk quota information if it was backed up at the Heal date.

Registry Replacement
The Agent changes the Registry as needed.

Restore Encrypted Files, Metadata, and Attributes
This section explains how Connected Backup considers encrypted files,
metadata, and attributes during retrievals.

Encrypted Files
If a technician, instead of the computer user, performs a Heal, Heal recognizes the
technician as the file owner. The user cannot gain access to the files. The
technician must decrypt the files for the user. The user can re-encrypt the files
after the Heal process completes.

Sparse Files
During a Heal, the Agent restores sparse files and directories that have the sparse
flag set, and restores all allocated sparse data that was backed up previously.

Multistream Files
Heal restores multistream data on files and folders.

Reparse Points
The Agent restores reparse points for files and directories. It also restores reparse
points for Directory Junctions.
Heal does not restore Volume Mount Points.
To ensure that each volume contains sufficient space for Heal, recreate the
Volume Mount Points that existed on the Heal date.
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Security Descriptors
During Heal, the Agent assigns a security descriptor to the file or directory that is
equivalent to the backed-up security descriptor.
If the Agent must create a directory to restore a file, and the Agent did not back up
the directory previously, the directory does not have a security descriptor. In this
case, Heal assigns a security descriptor that is the default value for the retrieve
location. The security identifier (SID) that Heal assigns to the owner field of the
security descriptor is the SID for the user performing the retrieve.
If you use Heal to recover a file that did not have a security descriptor when the
Agent backed it up, Heal assigns the default security descriptor for the file. The
security identifier (SID) that Heal assigns to the owner field of the security
descriptor is the SID for the user performing the Heal.

Open Files
If you use Heal to restore a system, and a file that the Agent needs is open or
inaccessible, the Agent tries to recover the file after the system reboot.

Requirements for Using Heal
This section describes the following types of requirements:


Disk space requirements



Software requirements



System requirements

Disk Space Requirements
To ensure that Heal works, the computer that you heal must have sufficient disk
space. To calculate disk space, Heal adds the sizes of the following files:


Files that are not currently on the system but present during the backup
selected for Heal.



System-protected files



The largest file that Heal must replace

If you are using Heal from media, your computer needs space to install the Agent
in a temporary directory.

®
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NOTE Heal does not support dual-boot computers.

System Requirements
Computers must meet the following system requirements before you can use Heal
to restore them:


The target computer must have the same version of the operating system as
the original computer. The following conditions apply:
 The target computer must have the same service pack installed as the

original computer. However, it can have different Windows updates or
security patches installed.
 The location of the operating system on the target computer can be

different than the location on the original computer.


The the target computer must have the same bit platform of the source
computer.
For example, to restore files to a computer that has a 64-bit platform, you must
use a backup from a computer that has a 64-bit platform. To restore files to a
computer that has a 32-bit platform, you must use a backup from a computer
that has a 32-bit platform.



The target computer must have the same system BIOS as the original
computer.



The target computer must have the same video BIOS as the original
computer.



Disk partitions on the target computer must be identical and at least as large
as those on the source computer.



The Agent must be configured to perform full system backups. If you are
restoring an Agent account to a new computer, make sure that you use the
same Agent configuration that the original computer used.

Access Requirements
To use Heal, you must fulfill the following access requirements:
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Log on to the computer you want to restore using a Windows user account
that has administrator privileges.



Make sure that the computer you are restoring can gain access to the Data
Center, unless you are using an account image for the Heal operation.
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Use Heal to Restore Files from Media
Depending on the scope of the Heal or the type of network connection that you
use, you may want to request an account image from the Data Center.
Use account images for Heal when the target computer is not connected to the
network or uses a slow network connection. You can gain access to the same
Heal options whether you use an account image or a direct network connection.
If the files restored during the Heal have many deltas, you might need to insert
and remove CDs or DVDs so that the Agent can reassemble the files to their
complete state.
Use the Support Center to request an account image for CD, or DVD distribution.
For more information, see “Order Media” on page 166. Also refer to Support
Center Help.

Use Heal to Restore Files from the Data Center
You perform a Heal operation with the Heal Wizard. The Heal wizard walks you
through the steps you have to complete to restore files. You open the Heal Wizard
from the Agent User interface. However, you can open the Heal Wizard only from
Agents that a technician configured to perform Full System backups.

Prepare to Use Heal to Restore Files from the Data Center
Before you start a Heal operation, complete the following tasks:


Consider the time required to restore a system using Heal. The time required
depends on the following factors:
 The number of files the Agent has to restore to the target computer.
 The type of connection between the target computer and the Data Center.
 The location of the files on the Data Center. The Data Center must recall

files that it previously migrated to HSM back to the server disk before it
transmits them to the Agent.
 The number of deltas that the Data Center must reassemble before

transmitting the file to the target computer.


Log on to the target computer. To do so, use a Windows user account that has
administrator privileges.



Be sure that the target computer can connect to the Data Center, unless you
plan to restore files from an account image.

®
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Back up the files on the target computer. This ensures that you can retrieve
the files after the Heal process completes. The first window of the Heal Wizard
lets you back up the files.



Close open applications. This ensures that the Agent can restore application
files during the Heal operation. The first window of the Heal Wizard reminds
you to close open applications.

Gain Access to Heal
You perform a Heal operation by using the Heal wizard. The Heal wizard walks
you through the steps you have to complete to restore files.
You open the Heal wizard from the Agent interface. The settings in the Agent
configuration determine whether users need a password to gain access to the
Heal wizard. When you specify Agent settings, you can specify one of the
following:


Do not require a password to perform Heal.



Require an account password to perform Heal. The account password is
the password associated with the Agent account or the encryption key for the
Agent account (if the Agent was upgraded from a Legacy PC Agent).



Require a technician ID and password to Heal a system.

If you configured the Agent to require a password, the Agent prompts the user for
this information before it opens the Heal wizard.
To gain access to the Heal wizard
1. Open the Agent interface, and from the Tools menu, select Heal.
2. If the Agent prompts you, enter a valid technician ID and password.
The Heal Wizard -- Welcome window opens.
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The following figure shows the first window of the Heal wizard:

Select Backup Dates for Heal
When you use the Heal wizard, you select a backup that occurred on a specific
date and time. The Agent uses this backup to Heal the files on the target system.
NOTE To ensure that the Agent can restore all of the files in the backup,
do not select a backup that completed with warnings. If you must select a
backup that completed with warnings, verify the history for the backup to
ensure that the Agent successfully backed up the files you want to
restore.

®

Autonomy Connected Backup Administering PC Agents

•
•
• 163
•
•
•

Chapter 11 Heal

The following figure shows an example of Heal Wizard - Select Backup window:

Select Heal Options
The Heal wizard prompts you to specify what type of files that you want to restore.
Select one of the following options:
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Do not roll back data files. Preserves data files that match Agent rules in the
User-Created Files category. For example, if a rule from the User-Created
Files category selects files with a .doc extension for backup, and you select
Do not roll back data files in Heal, the Agent does not Heal files that have a
.doc extension.



Roll back data files. Restores all of the files on the computer to their earlier
state. The Agent removes new files that a user created since the selected
backup date. You might need to use this option if a virus infected the computer
and you do not know which file(s) contains the virus.
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Agent Account Images on
Media
CHAPTER 12

This chapter explains how to retrieve files and restore a system from account
images stored on different types of media.


Account Image Overview



Order Media

Account Image Overview
An account image is information about an Agent account that an application called
the DataBundler collects and stores on the following types of media:


CDs. The account image might require multiple CDs



DVDs. The account image might require multiple DVDs



Network Attached Storage (NAS) devices. The account image consists of a
single file

An account image contains the following components:


Information about an Agent account



Backed-up data from a specific date



A version of the Agent interface that you can run from the media.

®
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NOTE Version 7.x media orders contain all of the files stored on the Data
Center for the account. Version 8.x account media orders contain only
files that were on the system on the date that you order the media.

Use account images to retrieve and restore files in the following situations:


The size of a retrieval request exceeds the capacity of the network connection
to download the files directly from the Data Center within a reasonable amount
of time.



The target computer is not connected to the network.



The target computer uses a slow network connection.
NOTE If you have to use Heal to restore a system, it might be more
efficient to use an image rather than to restore the system over the
network.

To gain access to the data in an account image, use the Agent interface included
in the account image. The Agent interface on media is similar to the Agent that
you install on a client computer. You can use the Agent User interface or the
command line interface.
The Agent on media contains the following subset of the features from the
standard Agent:


Retrieve. Lets you retrieve one or more files from the account image.



Heal. If the account image includes a full system backup, lets you Heal the
system using the account image.



History. Lists events for Retrieve and Heal.

Order Media
Technicians who host their Data Centers use the DataBundler application to
create account images on media. Technicians who do not host their Data Centers
use Support Center to order account images on media for users to retrieve.
Additionally, users can order images for themselves through the Account
Management Website.
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The Media Ordering Process
The DataBundler is an application that receives requests for images from the Data
Center. The DataBundler collects account data from the Data Center, creates an
account image, and puts the image in a target directory. It also creates media and
shipping labels that technicians who use the DataBundler can print.
The following figure illustrates the media ordering and account image creation
process.

Order Media from Support Center
To order media images for PC Agents from Support Center, use the Order Media
option.

To order media from Support Center
1. Log on to Support Center. Use a technician ID that has the Order Media
permission enabled.
2. Select the community that contains the account for which you want to order
media.

®
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3. Display the Account Summary page for the account, and select Tools > Order
Media.
4. Select or enter the following information:
 Backup date
 Media type
 Shipping data.
 Optionally, a case–sensitive password to gain access to the data on the

media
5. Click Submit Order.
For more information, refer to Support Center Help.

Order Media from the Account Management Website
To order media images for PC Agents from the standard Account Management
Website, use the Order CDs or DVDs option.

NOTE To allow users to order media using the Account Management
Website, you must enable this feature in Profile & Website Settings.

To order media from the Account Management Website
1. Log on to the Account Management Website.
2. Select Order CDs or DVDs.
The page displays only the backup sets available for the account associated
with the user who is logged on to the Website.
3. Select or enter the following information:
 Backup date
 Media type
 Shipping data.
 Optionally, a case–sensitive password to gain access to the data on the

media
4. Click Submit Order.
For more information, refer to Account Management Website Help.
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Agent History and Reports
CHAPTER 13

This chapter explains how to view Agent History and Support Center reports to
monitor Agent activity.


Agent History



Support Center Reports

Agent History
Use the Agent History to verify successful Agent activity or diagnose a potential
problem. The Agent History lets you view details about the following events:


Account recovery



Account registration



Backup



File list synchronization



Internal diagnostics



Retrieve

The Agent records details about activities and interactions with the Data Center in
a file that you can view on the Agent User interface History tab.
Each event entry contains the following information:

®
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The type of activity



The outcome of the event



The date and time that the activity started and ended

You can export the list of events to XML files that you can send to a technical
support representative.

View Agent History in the Agent Interface
View Agent history from the History tab in the Agent interface.
To view Agent history from the Agent interface
1. Open the Agent interface.
2. Click the History tab.
The History window opens.
To export the list of events on the History tab to a file:
 Click Export.
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The following figure shows the Agent History tab:

You can view details about a specific event, and export the details to a file.
To view details about an event
1. Open the Agent interface.
2. Click the History tab.
The History window opens.
3. On the History window, select an event.
4. Click View.
The View History Details window opens.
5. Optionally, to save the details to a file, click Export.

®
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The following figure shows an example View History Details window:

For more information, refer to Agent Help.

Viewing Agent History in Support Center
You can use Support Center to view the same list of events that you view in the
Agent History tab in the Agent User interface. When you select one or more
events, you can display detailed information about each event.
You can also view export details in an export file. If you enable diagnostics for the
account, Support Center displays the diagnostic information in the Agent History
view. You can export the content to a file that you can e-mail to a technical support
representative.
For more information, refer to Support Center Help.
To view Agent History from Support Center
1. Open Support Center.
2. Search for the account for which you want to view the Agent History.
3. Click Tools > View Agent History.
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4. To display the details for a particular event, select the event and click View.
5. To export the details to a TXT or XML file, click Export.
The Export dialog box opens.
6. Browse to the location on your computer where you want to store the details
.txt file, and click Save.
The Support Center names the file AgentLog_account_number.txt,
where account_number is the number associated with the Agent account.
7. To close the View History Details page, click Close.
The following figure shows an example of the entries in the View Agent History
window in Support Center:

®
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Support Center Reports
You can use Support Center to report on the accounts on your Data Center. You
can perform the following tasks:


Run default reports installed with Support Center.



Create and edit your own reports.



View and display charts.



Save and export reports in XML format.



Create account groups.

Default Reports
Support Center includes a default set of report templates. You can edit a default
report template to meet your needs. If you do this, save the edited default report
template under a new name. Doing so ensures that you do not lose the original
default configuration and that Support Center upgrades do not overwrite your
customizations.
For example, a future version of Support Center has updated default report
templates. When you upgrade Support Center, you overwrite the original default
versions. The following tables describes the default report templates that are
installed with Support Center:
Support Center 
report template

•
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Description

Account List

A list of accounts in Support Center. Support Center
sorts the list by community, then by account name.

Account Size

The amount of data that each account on the Data
Center stores.

Accounts Not Backing Up

A list of PC accounts that the Data Center has not
backed up for at least 10 days.

Activity Trends

A graph that shows the trends in the backup activity of
accounts. The graph shows data in gigabytes (GB)
backed up per day.

Backup Activity

A list of accounts by community, and the amount of
data backed up month to date.

Configurations

The assigned and actual Agent configurations for each
account.
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Support Center 
report template

Description

Data Access by Technicians

Information about which technicians accessed a
specific account and the type of activity that occurred.

Encryption Key Disclosure

Accounts with encryption keys that Support Center
technicians have viewed.

FileTypeSizes

The fifty most frequently backed-up file extensions by
size for accounts that have been through at least one
compaction cycle.

First Backup Size

Amount of data in megabytes (MB) backed up by a
group of accounts during the first backup.

Heavy Hitters

Accounts backing up the most data in MB.

Heavy Hitters Cumulative

Accounts with more than 20 GB of data on the Data
Center.

Last Backup

A list of 8.x accounts by community, with their last
backup date and status.

Restore Activity

A list of accounts by community, and the amount of
data restored by each account during the month to
date. Restore activity includes Agent Retrieve, iRoam,
Heal, and Sharing.

Report Components
To generate reports, you use the following components:


Report template. Contains the parameters you specify to generate a report.



Report. Contains the actual data, based on the parameters you specify in the
report template.

You can include the following types of information in reports:

®

Report area

Description

Account information

Name and demographic information for a group of accounts. For
more information about how to create groups of accounts, see
“Create Account Groups” on page 177.

Account summary

Status, Agent version, Agent configuration, and last backup date
for a group of accounts.
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Report area

Description

Current data sizes

Total number and size of files stored on the Data Center for a
group of accounts.

Account first backup
sizes

Total number and size of files transferred by a group of accounts
during their first backup.

Activity types

Number of backups, restores, and CD orders performed within a
given time frame.

Create Report Templates
To create a new report template
1. Click the Report Templates node under the community for which you want to
create a report.
If you want to, you can include subcommunities in the report.
The first Create Report Templates page opens.
2. Select the accounts for which you want to create a report.
3. Complete the subsequent report template pages to select the information that
you want to display in the report and specify how to sort it.
4. After you create the report template, save the template on the Support Center
server for reuse.
You can edit the report template any time.

Generate and View Reports
After you save a report template, you can run the corresponding report at any
time. You also can rerun the report in the future. Depending on the amount of data
that you need to compile the report, it can take minutes or hours for the report to
run. When the report is complete, Support Center displays the name of the report
under the Reports node.
To generate and view a report
1. Log on to Support Center.
2. Select a community.
3. Expand the Reports template node and select the type of report that you want
to generate.
4. Click Run Report.
The Report Queue page opens.
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5. Expand the reports node and select the report that you want to view.
The Report page opens. You can print the report, or download it to an XML
file.
For more information, refer to Support Center Help.

View Charts
You can include charts in reports. Support Center uses Adobe® SVG Viewer to
display charts. If your computer does not have Adobe SVG Viewer installed, you
can download it through Support Center. You can display a chart for the following
types of information:


Number of accounts



Account activity values



Total account data size values



First backup size values

Save Report Results in XML
On the Reports page, you can view reports in XML format. Typically, you have to
display the XML format only when Corporate Support requests this information.
After you display the XML format, you can copy and paste the content to another
file that you can send to Corporate Support.

Create Account Groups
You can use the reports feature to create a group of accounts and then change all
of the accounts in the group simultaneously. You can use the reports feature to
change accounts in the following ways:


Change the account status



Change the Agent configuration



Move the accounts to a different subcommunity

For example, you can create a report to find all accounts that have not performed
a backup in the past 90 days. You can then use the list of accounts to change the
status of the accounts to canceled or on hold. The account group is a temporary
entity. After you close the Support Center session, or after the session times out,
Support Center deletes the account group.
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